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Partnerships (1065)

The basics of data entry for a partnership (1065) return are the same as for the 1040. 
Field- and screen-level help, shortcut keys, and navigation throughout data entry all 
function as they do in the 1040 package. See the Drake Software User’s Manual: Tax 
Year 2011 for the basics of using the program.

What’s New in Drake for Partnership Returns

Drake programs its tax software according to the latest IRS rules and regulations. The 
2011 program reflects all changes to credits and deductions, including discontinua-
tions. For details on new regulations for 2011, see the IRS instructions for Form 1065.

ELEC Screen Changes

The ELEC screen has been revised for easier, more efficient selection of various elec-
tions available to corporations. For more information on choosing elections in Drake, 
see “Elections” on page 35.

Ownership Changes

New for 2011, ownership changes for partnerships should be entered on the OWN 
screen. Enter the date of ownership change at the top of the screen. From the Change 
in Percentages section, select a partner from the Partner’s ID Number and Name 
drop list. Enter the partner’s percentage of profit, loss, or capital received as a positive 
number or the percentage of profit, loss, or capital relinquished as a negative number. 
Press PAGE DOWN to open a new screen for additional ownership changes. (See 
“Ownership Changes” on page 20.)

Income and Deduction Screens

The data entry screens for income and deductions have been revised for easier data 
entry. Only two screens are now required in order to calculate ordinary business 
income for a return:
Tax Year 2011 1



What’s New in Drake for Partnership Returns Drake Software User’s Manual
• INC — Includes all items of income reported on Form 1065, page 1, lines 1b 
through 7, that do not require a separate schedule (Form 1125-A) or additional 
information (Income reported on Form 1065, Schedule K-1); also includes the 
Schedule K – Most Common Items previously included on screen 3.

• DED — Includes all deduction items reported on Form 1065, page 1, lines 9 
through 20, that do not require a separate schedule or form (Form 8846).

Screens 3 and TAX have been eliminated from the 1065 package.

Multi-State Apportionment

Previously, in order to prepare a multi-state return in Drake—for a company doing 
business in more than one state—you had to go to each individual state’s screens and 
enter its sales, payroll, and property factors. Drake would then calculate the apportion-
ment factor on that state’s tax form.

With the new APPT screen, you can enter the apportionment information for all states 
in one global location. The link to the APPT screen can be found on the States tab, or 
you enter APPT in the selector field and press ENTER. (See “Multi-State Apportion-
ment” on page 17.)

Cost of Goods Sold (Form 1125-A)

In years past, Schedule A, Cost of Goods Sold, was located on page 2 of Form 1065. 
Beginning with tax year 2011, entries on screen A produce a separate form, Form 
1125-A, Cost of Goods Sold. (See “Cost of Goods Sold (Form 1125-A)” on page 6.)

8609 Screen

The 8609 screen (for Form 8609, Low-Income Housing Credit Allocation and Certifi-
cation) has been reorganized for easier data entry. Among the changes:

• Fields required for both Form 8609 and Form 8609-A are now separated on the 
screen from the other information fields.

• Other fields for Form 8609-A are now located in the middle of the screen.

• Other fields for Form 8609 are now located in the bottom half of the screen.

Schedule K Screen Changes

The screens for Schedule K, Partners’ Distributive Share, have been changed for more 
efficient data entry. Changes include:

• If a form is required for a particular line, the corresponding field has been 
replaced with a link to the screen for the required form. For example, an entry on 
line 11, “Other Income,” might require that Form 6781, Gains and Losses From 
Section 1256 Contracts and Straddles, be completed. Rather than include a field 
for this line on screen K, the program now provides a link screen 6781.

• Ownership change dates, originally located on a third K screen, can now be found 
on new OWN screen. For more information about the OWN screen, see “Owner-
ship Changes” on page 20.
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Book Depreciation Schedules

A book depreciation schedule will now be printed when the Carry book accumu-
lated depreciation and amortization to Schedule L check box is marked on the L 
screen.

Adjustment and Override Worksheets

The Adjustment Worksheet and Override Worksheet are updated each year to help you 
understand what happens in the return when certain data is changed through the use of 
adjustment or override fields (Figure 1). 

Figure 1: Adjustment (+/-) and override (=) fields

By default, fields that allow overrides are preceded by an equal sign (=) and display 
red text. Data entered in these fields replaces, or overrides, program calculations. 
Fields that allow adjustments are preceded by a plus/minus sign (+/-) and display blue 
text. Data in these fields adjust program calculations by the amount entered. A posi-
tive number increases the calculated amount; a negative number decreases it.

The Adjustment and Override worksheets are available through the FAQ screen. To 
access them, open the FAQ screen, click the Screen Help button (or press 
CTRL+ALT+?) and click the links at the top of the window.

Updating a Prior-Year Return in Drake

If you prepared the tax return in Drake last year, you will need to update the return for 
the current year. A prior-year return can be updated in three ways:

• With all other returns in the program using Last Year Data > Update Clients 
2010 to 2011 (not recommended)

• As a single return (updated one at a time) using Last Year Data > Update Clients 
2010 to 2011 (recommended) 

• When you open the return for the first time in the 2011 program and are prompted 
to update it

When you update a 1065 return that was marked as “final” the previous year, the pro-
gram informs you that the return was marked final before prompting you to proceed.

Header Information

Screen 1 contains fields for the general information that is printed in the top section of 
page 1 of Form 1065.
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Name and Address

Use screen 1 to complete the partnership name and address section of Form 1065. For 
state purposes only, if the partnership has an alternate address (such as a P.O. box), 
you can enter it in the Address Line 2 field at the bottom of screen 2. (Access screen 
2 from the States tab, or enter 2 in the selector field and press ENTER.) 

Tax Year

The software uses the calendar year as the default period for all partnership returns. 
No date entries are required on screen 1 for a December 31 tax year-end.

Fiscal and 
Calendar 

Years

If the partnership uses a fiscal year (where the year begins in the current calendar year 
and ends in the next), specify the beginning and ending dates in the If not a calendar 
year section of screen 1.

Short-Year 
Returns

An entity may have a short-year return if changing accounting periods with IRS 
approval (Form 3115), or if this is its first or last year in business and the tax year is 
not a full year.

To indicate a short-year return, use the fiscal year date fields on screen 1 to indicate 
the beginning and ending dates for the current year. (These fields should not be used if 
the entity is filing a full calendar-year return.)

Boxes A through J

Enter most information for boxes A through J (top of Form 1065) on screen 1. Note 
that boxes D (Employer identification number), F (Total assets), and J (Schedule C 
and M-3 attached) are completed automatically based on information entered else-
where in the program. Other boxes are:

• Box A — Principal business activity

• Box B — Principal product or service

• Box C — Business code number (Press CTRL+SHIFT+S to search activity codes)

• Box E — Date business started

NOTE
The program adjusts calculations for depreciation and for gains and 
losses on sales of assets based on the entity’s tax year.

For information on filing with a 52-53–week year, see “Electing a 52-
53–Week Year (Initial Return)” on page 39.

NOTES
For more information on short-year returns, see IRS Pub 4163.

The program may not correctly calculate depreciation, gains, or losses 
for a short-year return. Depreciation for a short-year return can be man-
ually entered on screen 4562 or screens 6, 7, 8, and 9.
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• Item G — Initial, final, or amended return; address or name change; technical ter-
mination

• Item H — Accounting method (Select Cash, Accrual, or Other; if Other, enter a 
description of the method used.)

• Item I — Number of K-1 forms attached (Completed automatically based on the 
number of K1 screens filled out. Use screen 1 to override this number.)

Income and Deductions

Enter income and deductions on the INC (Income) and DED (Deductions) screens. 
INC screen amounts flow to Form 1065, page 1, lines 1b to 7. (Also see “Other 
Income (Loss)” on page 7.) DED screen amounts flow to Form 1065, page 1, lines 9 
through 20. “Other income” and “Other deductions” data is shown on attached state-
ment (STM) worksheets in View mode of the return.

Schedule K 
Items

Commonly used fields from Schedule K (including fields for income, dividends, char-
itable contributions, and distributions) are provided at the bottom of the INC screen.

Figure 2: Schedule K fields at the bottom of the INC screen

 Amounts entered in these fields should not be re-entered on the K screens.

For information on the Schedule K items at the bottom of the INC screen, see “Sched-
ule K (Partners’ Distributive Share Items)” on page 19.

NOTE
A technical termination occurs when there has been a sale or exchange 
of 50% or more of the interests in partnership capital and profits within a 
12-month period. On screen 1 in Drake, mark the Technical termina-
tion box and either Initial Return or Final Return as applicable.

NOTE
There is no “Charitable Contributions” line on page 1 of the 1065 return. 
Charitable contributions belong instead on Schedule K. Enter charitable 
contributions on either the INC screen or screen K, but not both.
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Gross Receipts

Enter gross receipts or sales and returns and allowances on the INC screen.

Cost of Goods Sold (Form 1125-A)

For cost of goods sold entries, complete screen A (Form 1125-A, Cost of Goods Sold).

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3, “Inventories.” Note that the inventory fields on screen L (Schedule L - 
Balance Sheet - Assets) are overrides; entries here will override inventory data from 
screen A.

Line 5, Other 
Costs

Drake provides two fields for line 5: Other costs - depreciation and Other costs - 
excluding depreciation (Figure 3).

Figure 3: Other costs and depreciation

For Other costs - depreciation, enter any depreciation amounts that relate to the cost 
of goods sold. Amounts entered in this field automatically adjust the total depreciation 
that is carried to page 1. For Other costs - excluding depreciation, use a CTRL+W 
worksheet. The depreciation amount is included on the statement for other costs.

Importing 
Trial Balance 

to Sch A

If using the trial balance import feature (see “Importing Trial Balance Information” on 
page 43), enter depreciation amounts directly into the appropriate fields on the trial 
balance worksheet, not in data entry. When the trial balance is imported, the COGS 
depreciation expense amount flows directly to the appropriate line of Form 1125-A 

NOTE
The IRS does not require a detail (CTRL+W) worksheet for gross 
receipts; therefore, if you are using the trial balance import feature, do 
not include a detail worksheet for this line—or for any other line that 
does not require a detail worksheet.

NEW FOR

 2011
Line 1a, Merchant card and third-party payments, is new for Form 1065 
in 2011; however, because the IRS requires that a zero (0) be entered on 
this line for 2011, the field for line 1a on the INC screen is inactive 
(grayed-out).

NOTE
On screen A, items 9a through 9f are direct-entry fields and follow the 
format of IRS Form 1125-A. For more information on completing these 
fields, press F1 or consult the IRS instructions.

NOTE Line 16b on the DED screen, is an adjustment field for depreciation 
from Form 4562 not entered on screen A.
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and is calculated accordingly. For more on depreciation and trial balance import, see 
“Depreciation” on page 50.

Ordinary Income (Loss)

Ordinary income or loss from other partnerships, estates, and trusts (line 4 of Form 
1065) flows from either screen K1P (Schedule K-1 from another partnership) or 
screen K1F (Schedule K-1 from a fiduciary).

Net Farm Profit (Loss)

The partnership’s net farm profit or loss (line 5 of Form 1065) flows from information 
entered on screen F (Farm Income and Expense). Farm profit or loss from other 
partnerships, estates, or trusts appears on line 4 of the return. To enter this informa-
tion, from the INC screen, click the links to screen K1P or screen K1F on line 4. 
Enter the farm profit or loss from other partnerships, estates, or trusts on line 1 of 
screen K1P or line 6 of screen K1F.

For information on farming partnerships with a corporate partner, see Pub. 225, 
Farmer’s Tax Guide.

Net Gain (Loss)

Any net gain or loss from the sale, exchange, or involuntary conversion of assets used 
in a trade or business activity (line 6 of Form 1065) comes from information entered 
elsewhere in the software.

Other Income (Loss)

Use the INC screen to enter amounts for the “Other income” line of the main form. 
Specific INC screen entries are displayed on attached statements in View mode of the 
return.

Amounts from the following screens also flow to line 7:

• Screen 6478 — Form 6478, Alcohol and Cellulosic Biofuel Fuels Credit

• Screen 8864 — Form 8864, Biodiesel and Renewable Diesel Fuels Credit

Additional fields on the INC screen include:

• Interest income on receivables

• Recoveries of bad debts deducted in earlier years

• Section 481 adjustments

• State tax refund (cash basis)

• Taxable income from insurance proceeds

• Other income (itemize)

To enter additional sources of income not shown, create a CTRL+W worksheet for the 
Other income (itemize) field on the INC screen.
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To enter other income (loss) from a partnership, estate, or trust, use the K1P or K1F 
screen (click the links on line 4 of the INC screen).

Compensation and Wages

Use line 9 of the DED screen to enter wages and salaries paid. Do not include guaran-
teed payments to partners or salaries or wages reported elsewhere in the return, such 
as the amounts included in COGS, elective contributions to a section 401(k) cash or 
deferred arrangement, or amounts contributed under a salary reduction SEP agree-
ment. (Drake automatically adjusts salary and wages for employment credits.)

Guaranteed Payments and Partner Health Insurance

Use the DED and K1 screens to report guaranteed payments and partner health insur-
ance. Note that guaranteed payments and health insurance are entered as separate 
amounts.

Guaranteed 
Payments

To report guaranteed payments to partners:

• Enter total guaranteed payments on the DED screen, line 10.

• Enter the guaranteed payments for each partner on line 4 of the Part III: K-1 
Direct Entries section of the partner’s K1 screen (Figure 4).

Figure 4: Part III section of screen K1

These entries should include any payments (or credits) to a partner for services ren-
dered. Include the use of any capital the partner provided if the payments (or credits) 
for that capital are not determined by the partnership’s income and can be allocated to 
a trade or business activity. These entries should not include any payments and credits 
that should be capitalized or any distributive shares of partnership profits.

Partner 
Health 

Insurance

To report partner health insurance:

• Enter the total deductible in the Partner’s health insurance field on the DED 
screen, line 10.

• Use screen K1, line 13M of the Part III: K-1 Direct Entries section, to allocate 
deductible payments for insurance that constitutes medical care for a partner or a 
partner’s spouse or dependents. (See Figure 4.)

NOTE
If the DED screen amounts do not equal the respective totals from the 
K1 screens, the program generates a “Guaranteed Payment Mismatch” 
message. The return cannot be e-filed until this message is cleared.
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These amounts flow to Schedule K-1, box 13, and are included in the amount in box 4 
of the partner’s Schedule K-1. For information on the partnership’s contribution to a 
partner’s Health Savings Account (HSA), see Notice 2005-8, 2005-4 I.R.B. 368.

Repairs and Maintenance

Use the DED screen to enter the costs of repairs and maintenance. See Form 1065 
instructions for IRS requirements regarding costs that can be entered here.

Bad Debts

Use the DED screen to enter the total of all bad debts that became worthless during 
the 2011 tax year, but only if these debts related to a trade or business activity. Deduct-
ible non-business bad debts should be entered as short-term capital losses on screen D 
(Schedule D, Capital Gains and Losses).

Rents

Use the DED screen to enter rent paid on business property used for a trade or busi-
ness activity. If the partnership rented or leased a vehicle, enter the total annual rent or 
lease expense incurred in the trade or business activity of the partnership, and then 
complete Part V of the 4562 (screens 8 and 9).

Taxes and Licenses

Use the DED screen to enter tax and license payment data. Amounts entered here flow 
to the “Taxes and licenses” line of Form 1065. Data is also generated on the ATT_PTL 
worksheet in View mode of the return.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) 
screen are carried to the tax computation (ATT_TAX) worksheet. The state tax 
amount carried from the ES screen may differ depending on which method of 
accounting (cash or accrual) is used, and which tax type is selected.

Interest 

The “Interest” line of Form 1065 refers only to the interest incurred by the partnership 
in a trade or business activity that is not claimed elsewhere in the return.

Use the DED screen to enter interest expense amounts. Do not include interest 
expense on the following:

• Debt required to be allocated to the production of qualified property

NOTE Cash-method partnerships cannot take a bad debt as a deduction 
unless the amount was previously included in income.

NOTE
Credit from Form 8846, Credit for Employer Social Security and Medi-
care Taxes Paid on Certain Employee Tips, automatically adjusts the 
amount of taxes and licenses on Form 1065.
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• Debt used to buy rental property or debt used in a rental activity

• Debt used to purchase property held for investment

• Debt proceeds allocated to distributions made to partners during the tax year

Self-Charged 
Interest

Self-charged interest rules (see Form 1065 instructions) do not apply if a partnership 
elects under Reg. section 1.469-7(g) to avoid the application of them. If the partner-
ship is making this election, a statement must be attached to the return. To attach the 
statement:

1. Open the SCH screen.

2. In the Statement number field, type 03.

3. Assign a title such as “Self-Charged Interest” (no quotation marks needed).

4. Enter the following data, each on a separate line:

• Partnership name

• Street address (U.S. only)

• City (U.S. only)

• Two-digit state code (U.S. only)

• ZIP code (U.S. only)

• EIN

• “REGULATION SECTION 1.469-7(G) DECLARATION” (no quotation 
marks needed)

Do not mark the In-house note check box at the bottom of the SCH screen.

You can also find these instructions by clicking F1 in the Statement number field on 
the SCH screen. For more information on self-charged interest rules, see the “Self-
Charged Interest” section of the Form 1065 instructions.

Depreciation

Use screen 4562 to enter depreciable assets for Form 1065, Form 1125-A, Schedule F, 
Form 8825, the RENT screen (rental other than real estate), and Section 754. (To 
associate a depreciable asset with an activity, make a selection in the For drop list at 
the top of the 4562 screen.)

Using the 
DED screen 

for Direct 
Entry

As explained further in “Line 16, Depreciation” following, the DED screen has two 
lines for direct entry of depreciation:

• Line 16a — Depreciation

• Line 16b — Depreciation claimed elsewhere on return

NOTE Using the SCH screen for this statement will not prevent the return from 
being e-filed.
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Any item entered in a depreciation field on the DED screen is added to the calcula-
tions from all 4562 screens. DED screen amounts are reflected on page 1 of Form 
1065 but are not shown on any generated Form 4562.

For more information on depreciation and the 4562 screen in Drake, see the Drake 
Software User’s Manual: Tax Year 2011.

Line 16, 
Depreciation

Line 16 of Form 1065 (Figure 5) is reserved for depreciation that (1) is from Form 
4562 and (2) is not claimed elsewhere. While the program pulls data from the 4562 
screen for this line, it also provides field 16b specifically for depreciation that is 
claimed elsewhere.

Figure 5: Depreciation line 16 fields from DED screen

Both lines 16a and 16b on the DED screen are adjustment fields and add to or subtract 
from software calculations that are based on entries elsewhere in the program. Enter 
only the depreciation claimed on assets used in a trade or business activity.

• Line 16a — An entry here is added to the depreciation from the 4562 screens. The 
amount on line 16a is not reflected on Form 4562. See field-level help for further 
instructions and information on how this field ties in to the 4562.

• Line 16b — Drake recommends using screen A (rather than the DED screen) to 
enter depreciation claimed on Form 1125-A. An entry on screen A adjusts any 
entry on line 16b of the DED screen and is calculated into the total deductions on 
Form 1065. If there is an entry on line 16b but not screen A, only the line 16b 
amount is calculated into total deductions.

Section 754 Use screen 4562 to enter section 754 depreciation. To associate the depreciable asset 
with section 754, select 754 from the For drop list at the top of the screen.

For information on allocating Section 754 depreciation to specific partners, see “Sec-
tion 754 Allocations” on page 24.

Section 179 Section 179 expense is not included on Form 4562, line 22, nor is it carried to line 16a 
of Form 1065. It is instead reflected on line 12 of Schedule K and distributed to each 
partner on Schedule K-1.

Reclassify to 
Amortization

To reclassify an asset from depreciation to amortization:

1. Open screen 4562 for the asset.

2. From the Method drop list, select AMT - Amortization.

IMPORTANT The depreciation fields on any screen should be used only if Form 
4562 is not required.
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3. Complete the applicable fields in the Amortization Information section, located 
near the bottom-left corner of screen 4562.

Depletion

Enter depletion amounts on the DED screen. Omit timber (use Form T, Forest Activi-
ties Schedules) and oil and gas properties. Depletion should be figured for each part-
ner. 

Retirement Plans

Use the DED screen to enter amounts for line 18, “Retirement plans, etc.” See the IRS 
instructions for guidance on what costs are acceptable for this line.

IRA for 
Employees

If the partnership contributes to an IRA for employees, include the contributions in 
salaries and wages on either the DED screen (“Salaries and wages” line) or screen A 
(“Cost of labor” line).

Payments to 
Partners

Do not use line 18 of the DED screen to deduct payments for partners to retirement or 
deferred compensation plans, IRAs, qualified plans, and Simplified Employee Pen-
sion (SEP) and SIMPLE IRA plans. Report these amounts, which are deducted by the 
partners on their own returns, on screen K, item 13d, code R. 

Employee Benefit Plans

Use the DED screen, line 19, to enter the partnership’s contributions to employee ben-
efits programs (such as insurance, health, and welfare programs) that are not part of a 
pension or profit-sharing plan included in line 18, “Retirement plans, etc.”

Amounts 
Paid for 

Medical Care

The line 19 amount should not include amounts paid for insurance that constitutes 
medical care for a partner, a partner’s spouse, or a partner’s dependents. For informa-
tion on entering amounts paid for medical care, see “Guaranteed Payments and Part-
ner Health Insurance” on page 8.

Pub. 541 IRS Pub. 541 states that premiums for health insurance paid by a partnership on behalf 
of a partner for services as a partner, are treated as guaranteed payments. The partner-
ship can deduct these payments as a business expense, and the partner must include 
them in gross income.

The partnership cannot deduct the premiums; however, if the partnership accounts for 
insurance paid as a reduction in distributions for that partner., go to the K1 screen for 
the partner and mark the Health Insurance distribution reduction box.

A qualifying partner can deduct 100% of the health insurance as an adjustment to 
income. The partner cannot deduct the premiums for any calendar month, or part of a 

NOTE
The software reduces the expense based on the credit amount calcu-
lated from Form 8881, Credit for Small Employer Pension Plan Startup 
Costs.
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month, in which he or she is eligible to participate in any subsidized health plan main-
tained by the employer of the partner or the partner’s spouse.

Other Deductions

Enter all other deductions on the DED screen. Drake calculates these amounts and 
incorporates the total into the “Other deductions” line of Form 1065.

The following deductions, credits, adjustments, and exclusions also flow to the “Other 
deductions” line:

• Amortization from Form 4562, Depreciation and Amortization

• Credit adjustment from Form 6765, Credit for Increasing Research Activities

• Credit adjustment from Form 8820, Orphan Drug Credit

• Exclusion from Form 8873, Extraterritorial Income Exclusion

• Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

Filing an Extension

Calendar year returns are due on April 17, 2012. By filing Form 7004, a partnership 
can extend the deadline five months to September 17, 2012. Fiscal-year returns are 
due on the fifteenth day of the fourth month after the end of the fiscal year.

To file a 1065 extension, use one of the following options:

• Go to the 7004 screen in Drake and select Generate an extension. Complete any 
other applicable fields on the screen.

• Go to the PRNT screen and select Prepare a Form 7004 extension.

Signing the Return

PIN signatures are required for e-filed returns. If e-filing a return, complete all fields 
on the PIN screen. A return cannot be e-filed if the PIN screen is not completed, 
including title and signature (name) of the general partner or LLC member manager.

If the return is prepared by a paid preparer, the preparer must complete the required 
information and sign the return in the space provided. If it is prepared by a partner or 
an employee of the partnership, select NONE in the Firm # and Preparer # drop lists 
on screen 1.

To have the preparer’s signature displayed on the printed return:

• If the return preparer and ERO (entered in Setup > ERO) are the same:

– Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-
ture box is marked for the preparer.

– Complete the PIN screen for the return.

• If the return preparer and ERO are not the same, go to the PRNT screen and com-
plete the field labeled PIN for preparer’s alternative electronic signature. The 
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PIN entered should match the one entered for the preparer in Setup > Pre-
parer(s). (For more information, press F1 in this field.)

Missing PIN 
Information

If you receive an EF message stating, “Missing Information on the PIN screen,” check 
the Title and Signature (name) of the partner signing the return. All applicable fields 
must be completed on the PIN screen. (Phone and e-mail are not required.)

Form 
8879-PE

You must receive the completed and signed Form 8879-PE before the return is e-filed. 
This form must be kept in the tax office for three years from the return due date or IRS 
received date, whichever is later. 

Amending a Return

To file a 1065 return that has been amended:

1. Go to screen 1 in data entry and select Amended return in section G.

2. Make changes as applicable to forms and schedules.

3. Go to the EF screen and select Amended 1065 in the left-hand column.

4. Go to the SCH screen and complete the following fields:

• Statement number — Type 1B.

• Title — Enter a statement title of 28 or fewer characters.

• Explanation text box — Identify the amended items by line number and 
explain what was changed and why. 

If amending just the K-1s, go to each K1 screen, select Amended K1, and make 
needed changes.

TEFRA and Filing Eligibility

A partnership subject to the TEFRA (Tax Equity and Fiscal Responsibility Act of 
1982) audit rules cannot file an amended Form 1065 to correct a partnership item 
reported on a previously filed return, but according to these rules, the tax matters part-
ner (TMP) must file a Form 8082 on the partnership’s behalf and request the IRS treat 

NOTE Setup > ERO must still be completed in Drake for e-filing. See the IRS 
instructions for further details on signature requirements.

CAUTION

When you amend a return in Drake, the amended information 
replaces the original in the data file. Before amending a return, you 
should archive the original to avoid losing previously submitted data. 
For more information on archiving returns, see “Archive Manager” in 
Chapter 6, “Return Results,” of the Drake Software User’s Manual: 
Tax Year 2011.

NOTE
When amending a 1065 return, all K-1s are amended, and the 
“Amended K-1” box on the return is marked, by default. To override this 
default, go to the PRNT screen and mark Do NOT check amended 
box on Sch. K-1.
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the Form 8082 as a substituted return. A partnership qualifying as a small partnership 
(see Section 6231(a)(1)(B)) – with 10 or fewer partners at any one time during the 
year – is exempt from the TEFRA audit rules and can file an amended Form 1065 and 
corrected K-1s to partners.

Additional Information

This section covers Schedule B (Other Information), state-specific information, and 
some program overrides.

Schedule B

The program has three screens for entering data for Schedule B, Other Information:

• Screen B — For all but lines 3 and 4

• Screen B1 — For lines 3a and 3b

• Screen B4 — For lines 4a and 4b

From screen B, you can access screens B1 and B4 by clicking the applicable hyper-
links or by pressing PAGE DOWN (once for screen B1; twice for screen B4).

Ownership If any foreign or domestic entity (corporation, partnership, or trust) owns, directly or 
indirectly, an interest of 50% or more in profit, loss, or capital of the partnership, use 
the Line 3a section of screen B1 to enter the entity’s name, EIN, type, country of orga-
nization, and maximum percentage owned in profit, loss, or capital.

If an individual or estate owns, directly or indirectly, an interest of 50% or more in 
profit, loss, or capital of the partnership, use the Line 3b section of screen B1 to enter 
the individual or estate’s name, ID number, country of citizenship, and maximum per-
centage owned in profit, loss, or capital.

If the partnership owned, directly, an interest of 20% or more, or owned, directly or 
indirectly, 50% or more of the total voting power of all classes of stock entitled to vote 
of any foreign or domestic corporation, use the Line 4a section of screen B4 to enter 
the corporation’s name, EIN, country of incorporation, and percentage owned in vot-
ing stock.

If the partnership owned, directly, an interest of 20% or more, or owned, directly or 
indirectly, an interest of 50% or more in profit, loss, or capital in any foreign or 
domestic partnership or in the beneficial interest of a trust, use the Line 4b section of 
screen B4 to enter the entity’s name, EIN, type, country of organization, and maxi-
mum percentage owned in profit, loss, or capital.

Line 6 
Require-

ments

If question 6 on screen B is answered Yes, Schedules L, M-1, M-2, and Section L of 
Schedule K-1 are not required and therefore not printed. The four conditions that must 
be met in order to answer Yes to this question are:

NOTE Which screens are required depends on the percentage owned. See 
Form 1065 instructions for calculating the maximum percentage owned.
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1. The partnership’s total receipts for the tax year were less than $250,000.

2. The partnership’s total assets at the end of the tax year were less than $1,00,000.

3. Schedules K-1 are filed with the return and furnished to the partners on or before 
the due date (including extensions) for the partnership return.

4. The partnership is not filing and is not required to file Schedule M-3.

Tax Matters 
Partner

The designated Tax Matters Partner (TMP) is the partner who is available to discuss 
tax information with the IRS. TMP information is printed at the bottom of page 3 of 
Form 1065. In Drake, the default Tax Matters Partner is partner #1 (the first partner 
entered on the K1 screen).

To designate a different partner, go to screen B and complete the Partner # field in the 
Tax Matters Partner section at the bottom of the screen. Note that most fields in this 
section are overrides; there is no need to enter additional information unless the part-
ner’s information differs from what is provided on that partner’s K1 screen.

If you don’t know the partner number, click K1 under the General tab of the Data 
Entry Menu. An Existing Forms List (see Figure 6) displays all partners with their 
respective numbers.

Figure 6: Schedule K-1, Partner Numbers

State-specific Information

Resident 
State

The program automatically generates a return for the partnership’s resident state. Use 
screen 2 to enter company information as it should appear on the state return. (Access 
screen 2 from the States tab, or enter 2 in the selector field and press ENTER.)

Company information includes the type of return that applies for state purposes (con-
solidated, composite, controlled group, multi-state) and state-specific dates and num-
bers for identification.

Contact 
Information

If certain contact information required for state purposes is different from that entered 
on screen 1, use screen 2 (accessible from the States tab) for the alternative data for 

TIP You can force these schedules to be printed from the PRNT screen.

NOTE The company information fields on screen 2 apply to the resident state 
only.
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registered office, principal place of business, “Books in care of,” and general contact 
information.

Screen 2 also has fields for the name, title, e-mail address, ID number, and telephone 
number of the partnership’s contact person.

Other States Data for other states must be typed in state data entry. To access state data entry, select 
the States tab from the return menu and select the desired states for state-specific 
screens (or type the two-letter state code in the selector field and press ENTER).

Multi-State 
Appor-

tionment

New for 2011: Enter sales, payroll, and property factors on the APPT Multi-State 
Apportionment screen (accessible from the States tab or by entering APPT in the 
selector field and pressing ENTER). This screen provides one central location for enter-
ing all state apportionment information instead of having to open each needed state’s 
screen. 

In addition to making data input faster and easier, the new feature provides two new 
worksheets: a summary worksheet (SA-SUM~) that can be used for verifying input, 
and a reconciliation worksheet (SA-REC) that ties the total of the state amounts to the 
federal return figures. These worksheets are available in View mode.

The individual state apportionment screens will continue to be available in Drake11 
but will be used to override data entered on the APPT screen. No state apportionment-
related screens will be updated from Drake10 to Drake11.

Figure 7: New APPT screen

APPT Screens The new APPT screen is opened to the Sales tab. Links at the top of this screen take 
you to the Payroll, Property, and Additional Property information tabs for each 
state selected (Figure 7). These screens and their uses are listed in Table 1. 

Table 1: APPT Screens

Screen Information

Sales Select state; enter sales, returns and allowance, and other 
income-related information for each selected state
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You may enter up to four states on one APPT screen. If you need more than four 
states, press PAGE DOWN for a new APPT screen. The same state can be entered more 
than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list when using the 
reconciliation worksheet. Not every item appearing on the federal return may be sub-
ject to multi-state apportionment. When you select OT, the data entered becomes a 
reconciling adjustment amount to aid in tying to the federal return. 

Enter as much or as little detail as the states require. If a state does not require any 
information to be entered, no information will flow to that state’s return.

Click Screen Help on each tab for state-specific information.

Other Information and Overrides

Use screen 1 to enter the following additional information:

Resident State — If the partnership has a mailing address in one state but does busi-
ness in another,  use the Resident State drop list to select the state in which the part-
nership does business.

Drake Codes and Overrides — For information on miscellaneous codes, invoice 
numbers, and override fields, see the following sections of the Drake Software User’s 
Manual: Tax Year 2011:

– “Listing a Different Firm, Preparer, or ERO on a Return,” in Chapter 2, 
“Installation & Setup.”

– “Miscellaneous Codes,” in Chapter 5, “Return Preparation.”

Payroll Enter salary, wage, commission, and labor amounts for 
each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors, plus select additional apportionment factors 
from drop lists

Additional Property Select additional apportionment factors from drop lists

Table 1: APPT Screens

Screen Information

NOTE
The Ending amount entered on the Property and Addition Property 
screens in Drake11 will become the Beginning amount for property on 
the APPT screen when the client’s return is updated next year in 
Drake12.

NOTE Worksheets outlining these and other adjustment and override fields 
are accessible through the FAQ (Frequently Asked Questions) screen.
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Schedule K (Partners’ Distributive Share Items)

Use the K screens to enter data for Schedule K, Partners’ Distributive Share Items. 
For your convenience, the most common Schedule K items can be answered on the 
INC screen. If you enter these amounts there, do not re-enter them on the K screens. 

Two screens are used for Schedule K: 

• Screen 1 of 2 — Income, Deductions, Self-Employment, & Credits

• Screen 2 of 2 — Foreign Transactions, Alternative Minimum Tax (AMT) Items, 
& Other Information

Press PAGE DOWN and PAGE UP to navigate from one K screen to another.

Schedule K-1 for 1065 (Partner Information)

Use the K1 screen to enter data for Schedule K-1, Partner’s Share of Income, Credits, 
Deductions, etc.

In the Type of Partner section, line G, select the box to describe the partner as either 
a General or LLC member-manager or a Limited or other LLC member (default 
is General). On line H, select either Domestic partner or Foreign partner (default is 
Domestic).

From the line I drop list (Figure 8), choose the type of partner (not the type of partner-
ship). If this box is left blank, the program uses the default selection of Individual.

Figure 8: K-1 Partner Type

NOTE
Note the screen K fields are primarily adjustment fields. Click F1 in a 
field to see what amounts are adjusted from elsewhere in the program, 
or see the adjustment and override worksheets, accessible from the 
FAQ screen.

NOTE The K screens should not be confused with the K1, K1G, or other 
related screens.
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Ownership Changes

Entry of ownership changes is new for the 2011 program. Previously, ownership 
changes were entered on a third K screen. Now, all ownership change information is 
entered on the OWN screen, which is accessible from the General tab of the Data 
Entry Menu. To use the OWN screen:

• At the top of the screen, enter the date the profit, loss, or capital interest in the 
partnership was exchanged by two or more partners. If profit, loss, and capital are 
all involved in a transaction, put the date in the Profit/Loss/Capital field only. 
Override date fields are provided if the loss or capital dates are different.

• In the Change in Percentages section, select the applicable partner from the drop 
list. (The drop list contains the names and ID numbers entered on each K1 
screen).

• Enter the percentage changes in profit, loss, or capital as positive amounts for 
increases and negative amounts for decreases. (See field-level help for more infor-
mation.)

• To enter additional ownership changes, press PAGE DOWN.

Printed Data A Summary of Change in Ownership worksheet (WK_POWN) is generated listing all 
partners and the ownership percentages and changes.

IRS K-1 Codes

A code sheet can follow the printing of each Form 1065 K-1 to help the taxpayer inter-
pret the various codes used on Schedule K-1. To have this sheet printed with all K-1 
schedules, go to Setup > Options > Form & Schedule Options tab and mark the 
Print Page 2 of Schedule K-1 check box. The codes can also be printed by marking 
the applicable box on the PRNT screen and are available from Tools > Blank Forms.

The Schedule K-1 may include asterisks with letter codes.

• An asterisk with a letter code indicates that multiple items have that code, or that a 
statement is required for the code.

• An asterisk at the bottom of a group indicates that there are more items than can fit 
in the space provided for that group and a statement is attached, or that the state-
ment is required (as in the case of “other” amounts).

Returns with Numerous Partners

For returns with a large number of partners, you have the option of deactivating calcu-
lation and printing of the K-1s while working on Form 1065. This option, which eases 

NOTE See FAQ item “P” in the program for more information on entering own-
ership-change information.

NOTE
Code sheets are not displayed in View mode. If the 1065 K-1 is 
selected for printing, it is printed first, followed by the statements per-
taining to that 1065 K-1. These are followed by the code sheets.
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the process of reconciling the 1065, is available by going to the PRNT screen and 
marking the applicable box under K-1 Items to Suppress.

Partner Overrides

To override calculated amounts for the partners, you can either make changes on each 
K1 screen or go to the SA screen for partner special allocations and make all changes 
there. For more information, see “Special Allocations” on page 24.

Foreign Addresses

If the partner has a foreign address, enter the Province (or State), Country, and 
Postal Code information in the Foreign address line of the Partner Name and 
Address Information section (along with the street address and city in the Address 
and City fields in section F.) Do not enter anything in the State or ZIP fields. Con-
versely, for a U.S. address, do not enter anything into the foreign address fields.

K-1 Export

Take the following steps to export a Schedule K-1 to a 1040 return.

1. Ensure that K-1 data is entered in the 1065 and the 1040 return has been created. 
(The K1P screen in the 1040 does not have to be created beforehand.)

2. In the 1065 return, go to View mode.

3. Click K1 Export in the View mode toolbar. A list of SSNs that cannot be 
exported appears, as applicable (Figure 9):

Figure 9: SSNs that cannot be exported

4. Click Next to continue. The Export K1s dialog box (Figure 10 on page 22) lists 
all client SSNs that can be exported. (To prevent an item in this list from being 
exported, remove the check mark to the left of it.)

NOTE After completing the K-1 entries for all partners, be sure to re-activate 
the calculation and printing of the K-1 from the PRNT screen.
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Figure 10: SSN ready to be exported

5. Click Export. The K-1 data will now appear the partner’s 1040 tax return.

Supplemental Information

Two types of supplemental information can be added to Schedules K-1:

• Supplemental data for all K-1s in a return

• Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s) enter the information in the 
Supplemental Information block of screen K1G.

To add supplemental information to an individual K-1, open a partner’s K1 screen and 
click the Supplemental Info link at the top of the screen. In the Supplemental Infor-
mation pane (Figure 11), enter information pertinent to the partner.

Figure 11: In this example, the information entered on the K1S screen appears
only the individual’s Schedule K-1.

Item M

If the answer to Schedule K-1, item M (“Did the partner contribute property with a 
built-in gain or loss?”), is “Yes” for all partners:

• Select Yes in the Item M on Schedule K-1 section of the PRNT screen.

NOTE
Basis information for individual partners should be entered in the 1040 
package in Drake; this information cannot be exported from the 1065 
package to a 1040 return. Such an import would override limitations 
and carryovers calculated in the 1040 program.
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• On screen K1G, select K1M - Built in Gain Loss Statement from the drop list, 
and type any supplemental information needed in the text box below.

If the answer is “Yes” for some partners but not others, use the individual partners’ 
Item M screens to report the supplemental information. The Item M screen is 
accessed by clicking the 8805/Item M tab at the top of any partner’s K1 screen. The 
supplemental information should list each property the partner contributed, the date 
the property was contributed, and the amount of the property’s built-in gain or loss.

Partner’s Adjusted Basis Worksheet

Use the Partner’s Adjusted Basis Worksheet (Basis Wks screen) to calculate a part-
ner’s new basis after increases or decreases are made to basis during the current year. 
A partner’s adjusted (outside) basis refers to the partner’s investment in a partnership. 
The basis is determined without considering any amount shown in the partnership 
books as capital, equity, or similar account. When a partner disposes of an interest in a 
partnership, the difference between the sale price and the adjusted basis is the taxable 
gain or loss.

The Basis Wks screen is accessible by clicking the Basis Wks tab at the top of the K1 
screen for a partner. (Access the K1 screen from the Data Entry Menu.)

Increases 
and 

Decreases 
to Basis

Increases to basis can include cash contributed, taxable income of partnership (includ-
ing capital gains), tax-exempt income of partnership, and partner’s adjusted basis of 
property transferred to a partnership.

Decreases to basis can include distributions of cash or property to partners, separately 
stated losses and deductions, nondeductible business expenses, and credit adjust-
ments.

Annual 
Update of 

Partner 
Information

When the program is updated to the next tax year, the end-of-year basis and liability 
amounts are automatically updated to the beginning of the year. Any loss or deduction 
carryover is updated to the beginning of the year and its character (ordinary loss, sec-
tion 179 expense, charitable contributions, etc.) maintained.

Entering 
Other 

Partner Data

Use the tabs at the top of a partner’s Basis Wks screen to access related screens for 
that partner.

• To access the K1 screen, click the K1 or K1 cont’d tab.

• To enter supplemental information that is specific to the individual partner, click 
the Supplemental Info tab. (To enter supplemental information that applies to all 
partners, use the K1G screen, accessible from the Data Entry Menu.)

NOTE
Basis information for individual partners should be entered in the 1040 
package in Drake; this information cannot be exported from the 1065 
package to a 1040 return. Such an import would override limitations 
and carryovers calculated in the 1040 program.

NOTE The Basis Worksheet is printed only when the option is selected on the 
PRNT screen.
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• To enter data for item M of Form 8805, Foreign Partner’s Information Statement 
of Section 1446 Withholding Tax, click the 8805/Item M tab.

Special Allocations

Use the SA screen (see Figure 12 on page 25) for partner special allocations to allo-
cate liability, capital, and K-1 Part III (Income, Deductions, Credits, and Other Items) 
amounts to individual partners without having to enter the information into each K-1 
separately. Amounts can be entered as dollar amounts or percentages. Calculations 
from the SA screen flow to the appropriate fields of each individual K-1.

To enter partner special allocations:

1. Open the SA screen, accessible from the General tab of the Data Entry Menu.

2. Make a selection from the Allocation type drop list at the top of the screen

3. Select an allocation method (percentage or dollar). If no allocation method is cho-
sen, the program will not include the allocations when calculating the return.

4. Select a partner from the Partner’s ID Number and Name drop list and enter the 
allocation figure in the Allocation Percentage or Amount field to the right of it.

Repeat these steps for all involved partners. To enter data for more than one allocation 
type, press PAGE DOWN to access a blank SA screen.

There is no limit to the number of partners than can be entered. If there are more than 
10 partners for whom you must enter special allocations, or an allocation type that 
must be allocated to more than 10 partners, press PAGE DOWN for a new SA screen.

Section 754 
Allocations

To allocate section 754 depreciation among specific partners:

1. Indicate an amount of section 754 depreciation using either (but not both) of the 
following methods:

• On screen 4562, select 754 from the For drop list.

• On screen K, line 13d, code W (“Section 754 depreciation”), enter the amount 
of section 754 depreciation to be reported to the partners.

2. Allocate the amounts. You can do this using either the K1 screen or the SA screen, 
but not both.

• K1 screen — On line 13, “Other deductions,” select code W and allocate the 
amount of section 754 depreciation for that partner. (For any partner not 
receiving an amount for section 754 depreciation, the code and a zero (0) must 
still be entered. A statement will still be produced for that partner.)

• SA screen — Select item 148 (Line 13 - W Other deductions) from the 
Allocation type drop list.

NOTE If a K1 screen is marked as final, none of the related screens for that 
partner is updated for the next year.
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Figure 12: Entering partner allocation information on the SA screen

Domestic Production Activities Deduction

A partnership does not take the deduction for Form 8903, Domestic Production Activ-
ities Deduction. Instead, the amounts pass through to the partners to report on their 
individual returns. The partners use the information to calculate their eligibility for the 
deduction. (For more information, see the IRS Form 8903 instructions.)

If Print K1-8903 worksheet for each partner is not selected on screen 8903, the 
amounts flow to line 12 of Schedule K-1 (codes Q and R). If this box is selected, the 
information flows to the K-1_8903, which is referenced on a statement. Code P is 
printed on line 12 of Schedule K-1 to indicate domestic production activities informa-
tion.

NOTE
The preferred allocation method is to use percentages. This prevents 
K-1 statements from being produced for any partners not receiving a 
section 754 deduction. (It may sometimes be necessary to enter a zero 
(0) for these partners in order to get the expected results.)

NOTES

Line 11 (“Income limitation”) of the Form 8903 is not applicable for the 
partnership because the income limitation is calculated at the partner 
level.

“Form W-2 wages” (on the 8903 screen) refers to the partnership’s W-2 
wages paid that are applicable to the Domestic Production Activities 
Deduction.
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K-1 Cover Letters

K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You 
can set up the global option to produce K-1 cover letters for all returns containing K-1 
schedules, or you can choose the option on a per-return basis.

Producing 
Letters for 

All Returns

To have the K-1 cover letters produced automatically with all applicable returns, go to 
Setup > Options > Optional Documents and mark the box labeled Include K-1 let-
ter with returns. The signature on the return can be indicated in one of three ways:

• By completing the Tax Matters Partner fields at the bottom of on screen B 
(Schedule B)

• By completing the partner information on the PIN screen (an entry here overrides 
the Tax Matters Partner information on screen B)

• By going to the K1L screen and entering the name and title of person signing the 
letter (an entry here overrides both screen B and the PIN screen)

Producing 
Letters for a 

Single 
Return

If no default has been set in Setup > Options > Optional Documents to produce K-1 
cover letters with all returns, you can take the following steps to generate letters for a 
single return:

1. Open the return and go to screen K1L.

2. At the bottom of the screen, enter the name and title of the person who will be 
signing the K-1 cover letter.

Once the required signing information has been entered, a K-1 cover letter will be 
generated for each person receiving a K-1.

Editing the 
K-1 Letter

As with other letters provided by the program, you can edit the text to suit your office 
needs and style.

To edit the text of the K-1 letter:

1. From the Home window, select Setup > Letters. The Client Communications 
Editor is displayed.

TIP
To prevent the partnership’s name and address from being generated 
in the header of the letter, go to the K1L screen and mark the Do not 
print entity information box.  (You must first select the Use Firm Info 
on Letters box at Setup > Letters > Setup > Letterheads and Mar-
gins for any entity info to appear as a header.)

NOTE If nothing is entered in any of the fields referenced above, the signature 
block will contain name of the partner on the first K-1.

TIP
Review the following sections of the Drake Software User’s Manual: 
Tax Year 2011 before making changes to letter templates:

- “Introduction to Letters in Drake” in Chapter 2, Installation & Setup

- The “Letter Keywords” section of Appendix C, Keywords
26 Tax Year 2011



Drake Software User’s Manual Schedule L (Balance Sheets Per Books)
2. Select Open > Partnership > Partnership K-1 Cover to view the template of the 
partnership K-1 letter.

3. Make any desired changes to the template.

4. Click Save.

Schedule L (Balance Sheets Per Books)

Schedule L is not required if:

• The partnership’s total receipts for the tax year were less than $250,000

• The partnership’s total assets at the end of the tax year were less than $1 million

• Schedules K-1 are filed with the return and furnished to the partners on or before 
the due date (including extensions) for the partnership return

• The partnership is not filing, and is not required to file, Schedule M-3

If the partnership meets all four of these conditions, go to screen B and select Yes for 
line 6. Because Schedules L, M-1, M-2, and Item L of Schedule K-1 are not required, 
they will not be generated with the return. (To force these items to be printed, go to the 
PRNT screen and, in the Items to Print section, select Force Schedules L, M-1, M-
2, & K-1 Section L.)

If any of the four conditions are not met, select No for line 6. Schedules L, M-1, M-2, 
and Item L of Schedule K-1 are required and will be printed with the return.

Flow of Information

Many entries made elsewhere on the return (for example, inventory information on 
screen A) flow to the generated Schedule L. Depreciable asset information, intangible 
assets, and amortization from the 4562 screen also flow to Schedule L. 

Direct entries on screen L include beginning- and end-of-year Cash, Trade notes and 
accounts received, and U.S. government securities. Schedule L data would come 
from the partnerships’ income statement, balance sheet, and equity and capital 
accounts.

The SCH2 Screen

The SCH2 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule L. This screen can be used in place of the actual L screen in 
Drake. In other words, if you use this screen for all applicable lines on Schedule L, 
you do not need to make any entries on the L screen.

To create a statement for a line, select the line from the drop list (see Figure 13) and 
enter descriptions and their corresponding amounts. Once the information is entered, 

NOTE
For an amended return, the K-1 letter automatically refers to the 
amended K-1. To edit the letter for an amended K-1, select Open > 
Partnership > Partnership K1 Amended and follow steps 3 and 4 of 
the previous procedure.
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or if additional descriptions are required for the line, press PAGE DOWN to access a 
new screen.

Statements The total amounts entered on the SCH2 screen do not appear on the actual L screen in 
the program. They are, however, printed on the return as applicable, with references to 
the corresponding statements.

The type of statement produced by the program depends on the selected line and the 
IRS requirements. If a line is required, a statement labeled “STATEMENT” is pro-
duced and is e-filed with the return. If a line is not required, a statement sheet 
(“STMT”) is produced and is not e-filed with the return.

Note that an e-fileable “STATEMENT” is referenced in the return (Figure 13).

Figure 13: Data entered on the “Other current assets” line will be attached as
an e-fileable statement and referenced on the applicable line of the return.

SCH2 and 
Trial Balance

Typically, one or more SCH2 detail screens are needed for Schedule L items. If using 
Drake’s trial balance import feature, be aware that SCH2 data cannot be entered 
directly into the trial balance worksheet, as they cannot be imported into the data 
entry. SCH2 detail screens must be created apart from the trial balance worksheet.

NOTES
All line selections are carried to the next-year program when the returns 
are updated. Screen descriptions are updated, with the year-end 
amounts carried to the beginning-of-year column.

To access the SCH2 screen from the L screen, click the SCH2 Screen 
hyperlinks on lines 6, 8, or 13 (or press CTRL+2).
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When the return is produced, Schedule L reflects the amounts imported from the trial 
balance worksheets (where direct entry was allowed). For more information, see 
“SCH2 Detail” on page 50.

Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year 
amounts. The program adjusts the capital account on Schedule L by the difference 
between the total assets and the total liabilities and capital before the adjustment.

(Example: If Assets = $1,000 and Liabilities and Capital = $900, the program 
increases the partners’ capital accounts by $100.)

To deactivate this feature for a specific return, go to the PRNT screen and select Turn 
off autobalance.

Schedules M-1, M-3 (Reconciliation of Income)

Schedule M-1 is required if the balance sheet’s total assets at the end of the year are 
greater than $250,000. Schedule M-3 is required if the balance sheet’s total assets at 
the end of the year equal or exceed $10 million.

Schedule M-1

Schedule M-1 shows all items of income and expense that are not subject to tax, plus 
those accounting items that are not income tax items. When required, taxpayers must 
reconcile book income with the taxable income.

Use the M1 screen to enter book-to-tax difference for Schedule M-1. Book-to-tax dif-
ferences are classified as permanent or temporary, and as favorable or unfavorable.

Depreciation 
and 

Amortization 
Adjustments

The program may make an adjustment for book-to-tax depreciation differences. The 
calculation is done with the following steps. (This procedure refers to “depreciation” 
throughout, but it applies for either depreciation or amortization.)

Table 2: Examples of Book-to-tax Difference for Schedule M-1

Difference Description Examples

Permanent Book or tax items that will never be 
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest

Temporary Items that will be reported for both 
tax and book purposes, but not dur-
ing the same tax year

- Depreciation
- Gains or losses on the sale of 

depreciated assets

Favorable Items that reduce taxable income - Instances in which tax depreciation 
amount is greater than book depre-
ciation amount

Unfavorable Items that increase taxable income - Disallowed meals & entertainment
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1. The amount reported on the Schedule L “Beginning of Year” accumulated depre-
ciation (line 10b, column a), is subtracted from the “End of Year” accumulated 
depreciation (line 10b, column c). This is the “book” depreciation amount.

2. This “book” depreciation amount is compared to the “tax” depreciation amount. 
(The “tax” depreciation amount is the depreciation amount reported on the return, 
including any section 179 amounts).

3. The differences between the “book” and “tax” depreciation amounts are carried to 
the appropriate form and line.

• If the “book” depreciation amount is greater than the “tax” depreciation 
amount, the difference is carried to either:

– Schedule M-1, line 4a

– Schedule M-3, Part III, line 25, as a negative amount

– Form 8916-A, line 2(L), as a negative amount for assets selected on the 
4562 detail screen for COGS

• If the “tax” depreciation amount is greater than the “book” depreciation 
amount, the difference is carried to either:

– Schedule M-1, line 7a

– Schedule M-3, Part III, line 25, as a positive amount

– Form 8916-A, line 2(L), as a positive amount for assets selected on the 
4562 detail screen for COGS

Schedule M-3

The Schedule M-3 section of the Data Entry Menu now includes direct access to the 
various M3 screens (Figure 14).

Figure 14: Data Entry Menu for M and M-3 schedules

If a domestic partnership reports on Form 1065, Schedule L, that its total assets at the 
end of its tax year equal or exceed $10 million (or that its gross receipts equal or 
exceed $250,000), it must complete and file Schedule M-3 instead of Schedule M-1.

NOTES
The program calculates total assets based on IRS requirements. For 
more information, see the Adjusted Total Assets Worksheet produced 
with the return.

Some calculated amounts flow automatically to M-3; some data must 
be manually entered on the M3 screen. Review all amounts on the M-3
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Parts II and III of Schedule M-3 reconcile financial statement net income (loss) for the 
tax return (per Schedule M-3, Part I, line 11) to net income (loss) on Form 1065, page 
5, “Analysis of Net Income (Loss),” line 1.

If the partnership is required to file (or voluntarily files) Schedule M-3, the partnership 
must file Form 1065 and all attachments and schedules, including Schedule M-3. 
Additional information could be required on the 8916 and SCH3 screens.

The SCH3 
Screen

The SCH3 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule M-3 (or Form 8916A). This screen can be used in place of the 
actual M3 screen in Drake. In other words, if you use this screen for all applicable 
lines on Schedule M-3 or Form 8916A, you do not need to make any entries on the 
M3 and 8916 screens. The total amounts entered on the SCH3 screen do not show up 
on the actual M3 and 8916 screens in the program. They are, however, printed on the 
return as applicable, with references to the corresponding statements.

To create a statement for a line, select the desired line from the drop list, then enter 
descriptions and their corresponding amounts. Once the information is entered, or if 
additional descriptions are required for the line, press PAGE DOWN to access a new 
screen.

As with the SCH2 screen, the type of statement produced by the program depends on 
the selected line and the IRS requirements. See “The SCH2 Screen” on page 27 for 
more information.

Schedule M-2 (Analysis of Partners’ Capital Accounts)

Schedule M-2 is used to show what caused changes during the year in the partners’ 
capital accounts. The amounts on Schedule M-2 should equal the total amounts 
reported in item L of all the partners’ Schedule K-1s.

Drake carries amounts entered in item L (Analysis of Capital Account) on the part-
ners’ K1 screen to the Form 1065, Schedule M-2, line 1, “Balance at beginning of 
year.”

Rental Activities

Income and expenses for rental real estate properties appear on Form 8825, Rental 
Real Estate Income and Expenses of a Partnership or an S Corporation. To make 
entries in Drake, use the 8825 screen.

If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use 
one screen per rental property. If a return has more than one 8825 screen, the program 

NOTE All line selections are carried to the next-year program when the returns 
are updated. 
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reports each property’s information on a separate column of Form 8825. Data from all 
8825 screens are transmitted to the IRS when the return is e-filed.

Line 14, Depreciation

If the program is calculating depreciation (entered on the 4562 screen) for the property 
listed on the 8825, do not enter the depreciation on the 8825 screen. Depreciation 
should be entered only if it is figured outside of the Drake program, and then the net 
results should be entered on screen 8825. The amount entered on line 14 is added to 
the depreciation calculated from the 4562 screens.

Carrying 
Information 

to Form 8825

To indicate that the information should be carried to Form 8825, select 8825 from the 
For drop list on screen 4562 (Figure 15). If there are multiple 8825 screens, use the 
Multi-form code box. For information on using the Multi-form code box, see the 
Drake Software User’s Manual: Tax Year 2011.

Figure 15: In this example, the program carries the 4562 information
to the third 8825 screen created.

Any depreciation information entered on the 4562 screen is carried to the correct 
Form 8825, based on the form and multi-form code selections at the top of the 4562 
detail screens.

Line 15, Other Expenses (list)

For rental properties with an “other” expense (line 15), enter the amount of Guaran-
teed payments or meals and entertainment in the appropriate fields (see Figure 16 on 
page 33). For rental properties with more than one “other” expense, double-click the 
text box on the Additional other expenses line to open a Detail Worksheet. Enter a 
description in the Description field and an amount in the Amount field.

NOTE Special steps are required if using the trial balance worksheet for multi-
ple rentals. See “Rental Expenses” on page 51 for more information.

NOTE For assets placed in service during the year, Form 4562 is required.

IMPORTANT

When selecting a multi-form code, note that the code should refer 
to an 8825 screen—not the 8825 form. For example, data from 
the third 8825 screen will be generated on the first Form 8825. To 
associate an asset with that information, you would enter a “3” for 
the screen (not a “1” for the form) in the Multi-form code box. For 
more information on Form 8825, see “Viewing Rental Activity 
Information,” below.
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Figure 16: Screen 8825, fields for line 15, “Other” expenses

Totals from the worksheet flow to Form 8825, and a statement from each property is 
printed with the return and is transmitted to the IRS when the return in transmitted.

Enter rental income the partnership receives on a K-1 on the K1P screen. This amount 
is carried to Form 8825, lines 20a and 20b. No entry is required on the 8825 screen.

Viewing Rental Activity Information

Rental activity data is viewed on the 8825 forms and accompanying statements.

8825 Forms — The two-page Form 8825 can contain information for up to eight 
rental activities. Each Form 8825 in View mode contains up to eight rental activities. 
If more than eight rental activities are entered, a second Form 8825 is created.

Figure 17: Multiple 8825 pages are created if more than eight rental activities

Each Form 8825 in View mode consists of one or more pages (depending on the 
number of rental activities) listing up to four rental activities per page. If more 
than four rental activities are entered, scroll down to the second page of the form 
when viewing.

• 8825 Statements – Statements are titled STM 8X, where X equals A to H for the 
first Form 8825. (For example, the statements for the first and second 8825 
screens would be labeled STM 8A and STM 8B, respectively.) As shown in 
Figure 18 on page 34, there are also 8825 attachments (8825_ATT) for other 
reporting information.
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Figure 18: 8825 statements and attachments

Self-Employment Income

If the Check to include in self-employment income box is selected at the top of the 
8825 screen, the amounts from the 8825 screen are included in the calculation for line 
14a of Schedule K and flow to each K-1. Self-employment calculations are shown on 
the WK_SE worksheet generated with the return.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. Drake 2011 carries 
the required adjustments to the appropriate line of the return and to the M-1.

Manually reducing the expenses/deductions or increasing the income for these credits 
causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following cred-
its:

• Form 6478, Alcoholic and Cellulosic Biofuel Fuels Credit

• Form 8864, Biodiesel and Renewable Diesel Fuels Credit

• Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction/expenses for the credit amounts 
for the following credits:

NOTE No adjustment is carried to the M-3 automatically for 2011.
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• Form 5884, Work Opportunity Credit

• Form 6765, Credit for Increasing Research Activities

• Form 8820, Orphan Drug Credit

• Form 8845, Indian Employment Credit

• Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-
tain Employee Tips

• Form 8881, Credit for Small Employer Pension Plan Startup Costs

• Form 8844, Empowerment Zone and Renewal Community Credit

• Form 8912, Credit to Holders of Tax Credit Bonds

• Form 8941, Credit for Small Employer Health Insurance Premiums

Elections

The ability to make certain tax elections is included in the business packages. Elec-
tions are selected from the Return Elections section of the ELEC screen (Figure 19).

Figure 19: Return Elections portion of ELEC screen

Making an Election in Drake

To indicate that the partnership is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry 
Menu).

2. Make a selection from the Election drop list.

Figure 20: Election drop list
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3. Complete all other fields as applicable. Press F1 in any field to learn if a field is 
required for your selection and the type of information that may be needed. For 
example, the help text for the Date or year-ending field shows that the field is 
required only for election options 08, 11, 13, 15, and 21, and it explains what, spe-
cifically, should be entered for each of these elections.

Figure 21: Help text for Date or year-ending field on ELEC screen

To open a new ELEC screen for an additional election, press PAGE DOWN.

Election Statements

Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced “STM ELXX,” where “XX” is the number of the 
election. For example, election 01 (General Election Statement) is generated as STM 
EL01.

The election statement includes the election title, election wording, and any additional 
information required for the election, such a date, amount, or location.

Entries for certain fields are sometimes included in the actual election statement; other 
times, they are included as separate lines. Signature lines are printed as needed on 
some statements.

Making Changes on the Fly

Use the PRNT screen to override program defaults.

NOTE
If the election option you selected is not listed in the help text for a field, 
then that field should be left blank. For example, if you chose election 
01 (General Election Statement), you would not need to enter anything 
into the Date or year-ending field (help text in Figure 21).
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Suppressing/Forcing Documents

To suppress or force the printing of certain documents, go to the PRNT screen and 
select the desired options. Many “on the fly” changes override options that are set up 
globally in Setup.

1065 Items The following Form 1065 items can be forced or suppressed from the PRNT screen.

• Force Schedules L, M-1, M-2 & K-1 Section L — Schedules L, M-1, M-2, and 
K-1 Section L are not printed unless required. To have these schedules printed 
with the return, select Force Schedules L, M-1, M-2 & K-1 Section L.

• Print Form 8893, Election of Partnership Level Tax Treatment — Select this 
box to generate Form 8893 with the return. (There is no equivalent 8893 screen, 
but the form is produced. All information for the form is available from other data 
entry screens.)

• Print Form 4562 — Form 4562, Depreciation and Amortization is not generated 
unless applicable. Select this box to force the Form 4562 to be printed. (To force 
Form 4562 for all returns, go to Setup > Options > Form & Schedule Options, 
and clear the check box labeled Print Form 4562 only when required.)

• Print next-year depreciation listing— Select this box to print the next year’s 
depreciation schedule if the option is not already selected in Setup > Options > 
Form & Schedule Options.

• Print inactive return — By default, the program does not generate a return for a 
partnership that is inactive. Select this option to override the default for an inac-
tive return.

• PIN — To have the preparer’s signature appear on the printed copy of return, 
enter the preparer’s PIN here.

• Items to Suppress — Select the boxes corresponding to any worksheets, forms, 
or functions to be suppressed in the return:

– ATT_PTL (Taxes and Licenses Attachment) or the ATT_PSW reference on 
page 1

– Estimated Tax Payment Summary

– Printing of WK_M2, Partners’ Capital Reconciliation Worksheet

K-1 Items Described below are Schedule K-1 items that can be forced or suppressed from the 
PRNT screen:

• Select to print:

– The partner’s adjusted basis worksheet

– Page 2 of Schedule K-1 (codes)

• Select to Suppress:

– Schedule K-1, K-1 letter, K-1_ATT, or WK_PBAS

– Schedule K/K-1 Comparison Worksheet for the Capital Account Reconcilia-
tion

– K1_179 for each partner

– Marking of “Amended K-1” box on printed Schedule K-1
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• Item L on Schedule K-1 (Partner’s capital account analysis) — Select the box 
(Figure 22) to indicate the calculation method used for the partners’ capital 
account. (If Other, indicate the method in the text box; this item is required.)

Figure 22: Items L and M of PRNT screen

• Item M on Schedule K-1 — Select this box to answer item M of Schedule K-1 
for all partners. To answer it for each individual partner, go to the partners’ K1 
screens. See “Item M” on page 22 for more information.

See field help (F1) for more information on the options available.

Overriding Other Setup Options

Filing instructions (federal and state) and envelope coversheets (partnership, IRS, 
state, and city) can be either forced or suppressed from the PRNT screen to override 
the global setting in Setup.

In addition, you can select Turn off autobalance to disable the autobalance feature 
(see “Autobalance” on page 29) and select Prepare a Form 7004 extension if send-
ing an extension application. (See “Filing an Extension” on page 13.)

Electronic Filing

Some partnerships with more than 100 partners are required to e-file Form 1065, 
Schedules K-1, and other related forms and schedules. For other partnerships, e-filing 
is optional.

Steps for e-filing Form 1065 are the same as for e-filing Form 1040, with the excep-
tion of Bankruptcy return, which must be paper-filed. For detailed instructions on e-
filing returns in Drake, see Drake Software User’s Manual: Tax Year 2011.

Additional Return Types

The following special types of business returns can be e-filed using Drake:

• Returns for entities using a 52–53-week year

• Short-year returns

• Inactive returns

For information on how to indicate a short-year return in Drake, see “Short-Year 
Returns” on page 4.
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Electing a 
52-53–Week 
Year (Initial 

Return)

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter 
data on both screen 1 and the ELEC screen.

To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year beginning 
and Fiscal year ending dates. Use MMDDYYYY format, as shown in the exam-
ple in Figure 23.

2. Mark the 52-53-week tax year box.

Figure 23: In this example, the fiscal year begins 01/01/11 and ends 12/28/11
(the Wednesday closest to the end of December), giving the entity a 53-week year for 2011.

3. Click the ELEC link to open the Election Options screen (Figure 24).

Figure 24: Elections for 52-53-week tax years

4. For line 1, select the month in which the 52-53–week year ends for the current fis-
cal year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the 
Fiscal year ending field on screen 1).

In subsequent years, only the 52-53–week tax year check box on screen 1 must be 
marked; the program automatically updates the dates.

Inactive 
Returns

Entities that are inactive but are still required to file returns may e-file inactive returns 
in Drake. To indicate that a return is inactive:

1. Go to the PRNT screen, accessible from the General tab.

NOTE
An entity that has filed returns in the past must complete only steps 1 
and 2 of this process. An entity that has never filed a return before must 
continue with steps 3 through 6.

NOTE
Once a 52-53–week year is selected, the entity must use that account-
ing period every year. To change accounting periods, the entity must 
submit to the IRS Form 3115, Application for Change in Accounting 
Method.
Tax Year 2011 39



Binary Attachments Drake Software User’s Manual
2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on 
the main form of the return (specifically, to the right of lines 1a through 1c). Zeros are 
displayed where required by the IRS in order for amounts to be properly included in 
the e-file data.

Common Error Codes

If one or more of the following IRS error reject codes is generated when you e-file a 
1065 return, you must contact the IRS for further information.The e-file help desk 
number is (866) 255-0654.

• Reject Code 900 — The return type indicated in the return header must match the 
return type established with the IRS for the EIN.

• Reject Code 905 — Electronic Filing Identification Number (EFIN) in the Return 
Header must be listed in the e-file database and in accepted status. If you get this 
reject code, you must update your e-file application to include the 1065 return 
type. (See Figure 25.) This can be done at the IRS website or by calling the IRS 
e-Help Desk at (866) 255-0654.

Figure 25: The 1065 box must be marked on Form 8633 in order to e-file Form 1065.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be printed, 
scanned into the computer, and attached to the return in order to be e-filed with the 
return.

You can attach PDF files to federal partnership (1065) returns for e-filing. The PDF 
Attachments screen is accessible from the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake:

NOTE All EF messages must be cleared in order to e-file an inactive return.
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1. Creating a PDF document to be attached

2. Informing the program that a PDF document will be sent with the return

3. Attaching the PDF document for e-filing

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return.

2. Save the document to your client’s DDM file, your computer’s desktop, or any-
where you can readily find it.

Adding PDF 
Documents 

in Drake

To indicate in the software that a PDF document will be sent with the return:

1. Open the return in Drake and go to the PDF Attachments screen, accessible from 
the Electronic Filing section of the General tab.

2. Fill out the columns on the PDF Attachments screen. See Table 3 for examples.

3. Exit the PDF Attachments window.

Because you’ve indicated that a PDF document is attached, the program generates an 
EF message regarding the attachment when the return is calculated.

Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the return, click View. If anything was entered in the PDF Attachments 
window (see “Adding PDF Documents in Drake,” previously), there will be two 
PDF–related items in the View/Print window:

• An EF Message alert (item #1 in Figure 26 on page 42)

• An Attach PDF button on the toolbar (item #2 in Figure 26 on page 42)

TIP It’s a good idea to use the DDM scanning feature for this step.

NOTE
Many types of documents (for instance, documents created in Microsoft 
Word) can be printed or “saved” as PDF documents if you have a PDF 
printer (such as Adobe Reader) installed.

Table 3: PDF Attachment Window Columns

Name of Column Description Examples

Reference Source Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4
- Form Instructions for 1065

Description Description of form or document to 
be attached

- Title of house on Oak Street
- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf
- AppraisalLot1234.pdf
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Figure 26: The MESSAGES file (1) and the Attach PDF button (2)

2. Click the MESSAGES file to view EF messages, including information on how to 
attach the required documents to the return.

3. Click the Attach PDF button. The EF PDF Attachments window displays the 
information entered on the PDF Attachments window in data entry. A red X 
means the document has not yet been attached; a green check mark indicates an 
attached document.

Figure 27: The EF PDF Attachments window

4. Click the row of a document to attach.

5. Click Browse.

6. Browse to the proper folder, select the PDF file to attach, and click Open (or dou-
ble-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a 
completed return (and show a green check mark), recalculate the return. The return is 
ready to be e-filed.

Printing Generated Documents

In some instances, Drake generates a document that must be printed, signed, and 
scanned back into the computer to be attached to the return. For example, if Form 
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3115, Application for Change in Accounting Method, is present in a partnership 
return, message 1515 is generated when the return is calculated.

Figure 28: EF message 1515

As shown in Figure 28, the EF message states that attachments are required. You 
would then need to obtain or complete the statements, scan them into the computer, 
save them as PDF documents, and attach them to the return.

Importing Trial Balance Information

Drake trial balance import feature allows data to be imported into a 1065 return from a 
trial balance worksheet. The trial balance template and importing function has the fol-
lowing benefits:

• Eliminates the need to duplicate entries

• Reduces data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that exist in the 2011 
version of Drake Software. If you haven’t already, create a client file in Drake 2011 or 
update an existing client file from the prior year. Like several other functions of the 
tax software, this new feature requires Microsoft Excel (version 2000 or later).

In addition, take these actions to ensure the trial balance import works properly:

• Enable Macros — The trial balance import function uses macros in Microsoft 
Excel. Check your Excel settings to ensure that macros are activated and that 
macro security is set to “medium.” To do so, go to Tools > Options in Excel and 

NOTE A flow chart of the trial balance importing process is available as 
Appendix A, Trial Balance Import (pages A-1 to A-2 of this manual).
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select the Security tab. Click Macro Security and select Medium, then click 
OK.

• Disable Autobalance — When autobalance is disabled, the program is prevented 
from automatically adjusting the year-end retained earnings or capital amounts, 
thus allowing you to see any discrepancies in the balance sheet. To disable auto-
balance, go to the PRNT screen and select Turn off autobalance.

Figure 29: Disable autobalance in Other Return Options section of PRNT screen

• Force Schedule L — By default, the program does not display the balance sheet 
amounts on the return if the entity does not meet the filing requirement. If this is 
the case, you need to override the default in order to have the amounts shown on 
Schedule L. To force the Schedule L amounts to be printed, go to the PRNT 
screen and select the Force Schedules L, M-1, M-2, & K-1 Section L box.

Figure 30: Force Schedule L box for 1065 package

• Check for Detail Worksheets — The trial balance import allows only those 
detail worksheets required by the IRS. Check updated returns for detail 
(CTRL+W) worksheets that are not required. For example, the IRS does not 
require a detail worksheet for the Gross receipts field on the INC screen; if a 
return has a detail worksheet for that field, the trial balance will not import cor-
rectly into the return. Detail worksheets are indicated by red shading, as shown in 
Figure 31 on page 45.

NOTE
In Windows 7 and Microsoft Vista, click the Office button in the upper 
left and then click the Excel Options button at the bottom of the win-
dow. Next, select Trust Center from the list at left, then click the Trust 
Center Settings button. Select Macro Settings from the list on the left, 
then choose Disable all macros with notification. Click OK.
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Figure 31: Example of an “unnecessary” detail worksheet

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” 
on page 47 for more information on using detail worksheets in the trial balance.

Preparing Financial Data for Import

To prepare the financial data for importing into the return, the data must be entered 
into Drake’s specially designed trial balance template. Once this information is 
entered and saved, it can be imported into the return.

Opening a 
Template

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.

2. Click Import > Trial Balance Import in the menu toolbar. The preliminary Trial 
Balance Import dialog box is opened.

3. Click Create New or Open Existing. If opening an existing file, click Open after 
selecting the correct file.

4. Click Enable Macros in the Security Warning box that appears.

The trial balance template is displayed in Microsoft Excel.

Naming 
Convention

Whenever a new template is opened, the tax software assigns it a default file location 
and name. Trial balance templates are saved in the TB folder of your Drake11 soft-
ware. The file name consists of the client name as entered in Drake, plus “TB” for 
“trial balance,” plus the “.xls” suffix assigned to all Excel files, as shown in Figure 32.

Figure 32: Example of trial balance template file name

To change the name of a file in Excel, select File > Save As and assign the new name.

NOTE
In Microsoft Vista and Windows 7, you will see a Security Warning 
message with an Options button. Click Options to open the Security 
Options dialog box, then select Enable this content. Click OK.
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Template 
Structure

The trial balance template consists of three title rows and six columns. The Entity 
Name and Year End title rows can be edited; double-click a row to change the title. 
Columns are described in Table 4.

Displayed at the bottom of the trial balance worksheet are the calculated amount for 
Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the 
balance sheet is out of balance and, if applicable, the out-of-balance amount 
(Figure 33; see also Figure 36 on page 48).

Figure 33: Schedule M-1 amount (1); totals (2); and indication of balance (3)

Following are instructions and guidelines for using the trial balance template to 
assemble financial data for importing into data entry.

Entering Financial Data

When a new trial balance file is opened for a return, all debit and credit amounts are 
zero ($0). All data must be entered manually into the template.

Direct Entry Most cells in the trial balance worksheet are view-only. In a new template, editable 
debit and credit cells are indicated by a dollar amount ($0).

Table 4: Trial Balance Template Columns

Column Description

Account Title Title of account

Debit/Credit Debit and credit amounts

Import to Screen and line in Drake to which the debit or credit 
amount is imported

Reported On (form, page, 
schedule, and/or line

Location of the amount on the printed return

Other Information Additional details for preparers; see “Details for Pre-
parers” on page 49.

NOTE
Some data cannot be imported from the trial balance and must be 
entered directly into the data entry fields within the program. For more 
on these categories of data, see “Special Conditions” on page 49.
46 Tax Year 2011



Drake Software User’s Manual Importing Trial Balance Information
Detail 
Worksheets

Some cells require more detail than can be entered on a single line. These cells are 
indicated by buttons.

Figure 34: Example of cells that require worksheets

Click a worksheet button to open a worksheet in a new tab. Figure 35 shows an exam-
ple of the “Other Income” worksheet.

Figure 35: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the TB tab (labeled “1” in Figure 35), or 
click the Return button above the worksheet tabs (labeled “2” in Figure 35). Note that 
a detail tab (the “Other Income” tab in Figure 35) might include one or more detail 
worksheets (labeled “3” in Figure 35).

NOTE
Do not create detail worksheets in data entry if the trial balance work-
sheet does not provide an equivalent detail worksheet. Otherwise, the 
trial balance will not import correctly.
Tax Year 2011 47



Importing Trial Balance Information Drake Software User’s Manual
Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are 
out of balance, the worksheet highlights the out-of-balance amount (Figure 36).

Figure 36: Out-of-balance amount is highlighted if columns are out of balance.

In addition to credit and debit totals, the main trial balance worksheet shows the net 
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the software.

Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. To re-name 
a file when saving, select File > Save As. (In Windows 7 and Microsoft Vista, click 
the Office button in the upper left and then click Save or Save As.) For more informa-
tion on file names in the trial balance program, see “Naming Convention” on page 45.

Importing Data into a Return

Once a trial balance worksheet has been set up for a client in Drake, the trial balance 
information can be imported into the program and calculated into the return.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.

2. Click Import > Trial Balance Import from the menu toolbar. The preliminary 
Trial Balance Import dialog box is opened.

3. Click Next.

4. Enter or select the trial balance file to be imported. Use the Browse feature if nec-
essary. By default, each trial balance file is an Excel (.xls) file showing the client 
name and ending in “TB” for trial balance, as shown in the example in Figure 37 
on page 49. (See “Naming Convention” on page 45.)

NOTE The data cannot be imported if the worksheet is out of balance.

NOTE
Not all trial balance data can be imported directly into a return. For 
information on program limitations, see “Special Conditions” on 
page 49.

NOTE
If you are already in the Trial Balance Import tool for the selected return, 
go to the Trial Balance Import window in Drake and start at Step 3 of 
the following procedure.
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Figure 37: Selected file to import

5. Select the Trial Balance Additional Import Options. (See “Additional Import 
Options” following this procedure.)

6. Click Next and wait for the import to be completed.

7. Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all 
selected data from the trial balance worksheet has been imported into the return. This 
can be seen both in the data entry screens and on the generated return.

Additional 
Import 

Options

By default, the program imports the following additional information when importing 
the trial balance data:

Special Conditions

Some trial balance items cannot be entered into the trial balance worksheet and must 
be typed directly into Drake data entry. Other items should be entered into the work-
sheet for balance purposes but are not carried to data entry; these must be entered sep-
arately and the calculated results compared to the trial balance worksheet.

Details for 
Preparers

Most trial balance items go directly to the location indicated in the program and on the 
return. For example, the amounts shown in Figure 38 go to Schedule L, line 1, column 
d in the program and are shown on page 5, line 1, column d of the 1065 return.

Figure 38: Indication of where an amount will go in Drake and on the return

Not all figures can be imported directly, however, and some amounts are optional. 
Drake has provided an “Other Information” column in the trial balance worksheet to 

Buildings & other depreciable assets Accumulated depreciation

Goodwill & other intangible assets Land

Rental real estate information Accumulated amortization
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indicate special conditions and additional information regarding certain rows. Table 5 
describes the most common notes in this column.

All “does not import” notes are accompanied by further instructions in the column to 
the left of the “Other Information” column, as shown in Figure 39.

SCH2 Detail Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is 
required for an item marked “does not import” on the trial balance.

Figure 39: SCH2 screen required for “does not import” items

To complete an SCH2 detail screen in data entry:

1. Open the SCH2 screen for the return.

2. Select the line number from the SCH2 drop list.

3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of Schedule L, press PAGE DOWN and repeat steps 
2 and 3. Data is saved automatically upon entry.

When the return is produced, Schedule L of the return reflects both the amounts 
imported from the trial balance worksheet and the totals of the amounts entered on the 
SCH2 screen.

Depreciation Partnership (1065) returns can have up to four components of total depreciation:

Table 5: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only but is 
not included in the totals shown on the trial balance.

does not import Information cannot be imported and must be entered on the 
appropriate screen in Drake. Screen is specified in the 
“Reported on” column to the left of “Other Information.”

optional Amount is optional; not required for import, but could require 
direct entry in the software.

enter as negative number Some deficits must be entered as negative numbers.

import includes the calculated 
change in inventory

Used for “total purchases”; when calculating cost of goods 
sold (COGS) in the return, the program takes the change in 
inventory into account for the Schedule A calculation.
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• COGS 

• Real estate rental

• Rental other than real estate

• Any remaining depreciation

For trial balance purposes, enter depreciation amounts directly into the appropriate 
fields on the trial balance worksheet. Note that rental expense detail worksheets are 
required for 8825 and RENT depreciation.

When the trial balance is imported, the COGS depreciation expense amount flows 
directly to the appropriate line of Schedule A on the return, and the rental depreciation 
expense amounts flow directly to the appropriate lines of the 8825 and RENT screens, 
as applicable. Because the remaining depreciation can comprise any number of assets, 
the amount entered on the trial balance does not flow to the return. To ensure that each 
component of the total remaining depreciation is calculated into the return, each asset 
must be entered on the applicable depreciation screens in data entry (Figure 40).

Figure 40: Enter depreciable asset data on a 4562 detail screen,
or enter the total depreciation on the override screens

Rental 
Expenses

The following information applies only for partnerships with multiple rental proper-
ties.

The partnership trial balances include lines for rental income and expenses. Both 
rental expense items require a trial balance detail worksheet.

NOTE
Enter 8825 and RENT depreciation amounts in the detail worksheets 
for importing purposes, but be aware that the 8825 and RENT screens 
in the program will need to be edited if 4562 detail screens (see 
Figure 40) are used.

NOTE

Entering the remainder of the depreciation on the trial balance work-
sheet helps ensure that the balance sheet balances and provides a way 
to check that the amount on line 1 of Schedule M-1 is correct. Compare 
the calculated line 1 at the bottom of the trial balance to the equivalent 
line on Schedule M-1 of the calculated return. If the depreciation 
amounts match but the line 1 amounts differ, an M-1 adjustment could 
be required.
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Figure 41: Rental expense rows on a trial balance worksheet

When imported, the rental expense data entered on the trial balance worksheet appears 
on either the 8825 screen (if real estate rental) or the RENT screen (if rental other than 
real estate).

Because the trial balance worksheet has only one detail screen per rental type, the 
importing function does not accommodate entities with multiple rental properties or 
expenses; however, the following procedure allows the trial balance to remain in bal-
ance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.

2. Enter the income totals on the trial balance sheet and the expense totals on the 
applicable detail sheets (Figure 41).

3. Ensure that the balance sheet is in balance.

4. Import the trial balance worksheet into the return. The applicable screens in data 
entry now contain the figures entered on the trial balance worksheet.

5. Compare the M-1, line 1 amount on the trial balance to the M-1, line 1 amount on 
the calculated return to ensure that they match.

6. Complete all 8825 or RENT screens in data entry, as applicable, for the individual 
rental properties or items.

7. Delete the 8825 and RENT screens that were imported from the trial balance (the 
screens reflecting the total rental expenses).

NOTE
If the amounts do not match, review the imported amounts to ensure 
that all data was imported. If the data appeared to have been imported 
correctly, an M-1 adjustment could be necessary.

NOTE
To delete a screen in data entry, open the screen and press CTRL+D. If 
a multiple forms list appears, ensure that the screen to delete is 
selected, then click Delete.
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Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any item. Drake customers can now fill out and e-file certain Forms 3115 and 
related schedules and attachments for partnership returns. This section provides 
instructions for completing this form and related schedules and attachments in Drake.

Accessing Screens for Changing Accounting Method

Several screens may be required to complete Form 3115. These screens are accessible 
from the Change in Accounting Method box, located under the first Other Forms 
tab of the Data Entry Menu.

The screens accessible from the Change in Accounting Method section include:

• Screen 3115 (Change in Accounting Method) — Used to access fields for Form 
3115, including Schedules A through D

• Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

• Screen ATT (Explanations and Attachments) — Used to create and view cer-
tain attachments to be generated by the software

• Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment) — Used to complete 
certain parts of Form 3115 that require specific attachments

Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in Figure 42 
on page 54) that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake. The first should be 1, the second 2, and so on. When using 
other screens, such as the 311E or ATT screens, you can use those numbers to indicate 
which instance of Form 3115 the 311E or ATT screen should be associated with; see 
“Screen 311E Multi-form Codes” on page 59 for more information.

Form 3115 Screens

When you open the 3115 screen from the Data Entry Menu, the program displays the 
first of five 3115 screens. These five screens are:

NOTES

In some cases, Form 3115 must still be paper-filed. See “Parts I and III,” 
starting on page 54, for details.

Applicants filing Form 3115 must refer to the Internal Revenue Bulletins 
(available at www.irs.gov) to determine if the IRS has published an 
accounting method revenue procedure, revenue ruling, notice, regula-
tion, or other guidance relating to the specific method to be changed. 
See Pub. 538, Accounting Periods and Methods.

NOTE If only one Form 3115 is being submitted, you do not need to enter any-
thing in the Multi-form code box.
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• Parts I, III (Form 3115, Parts I and III)

• Parts II, IV (Form 3115, Parts II and IV)

• A, B, C (Form 3115, Schedules A, B, and C)

• D - I, II (Form 3115, Schedule D, Parts I and II)

• D - III (Form 3115, Schedule D, Part III)

As shown in Figure 42, you can access these 3115 screens by clicking a link at the top 
of any other 3115 screen.

Figure 42: Tab links on 3115 screen

The next few sections of this document provide instructions for completing the vari-
ous screens for Form 3115 (including Schedules A through D).

Parts I and III Use the Parts I, III screen to complete the following sections of Form 3115:

• General Information

• Part I, Information For Automatic Change Request

• Part III, Information For Advance Consent Request

General 
Information

Complete all applicable fields in the General Information section. Note that the 
fields for business activity and tax-year change are override fields (Figure 43). Com-
plete these fields only if you want to override the equivalent information entered on 
screen 1 or screen K.

Figure 43: Override fields in the General Information sections of the Parts I, III screen

Part I Not all applicants are eligible to use the automatic change request procedures. After 
answering 1a, 1b, and 2 in Part I - Information for Automatic Change Request, 
click the blue Parts II, IV tab at the top of the screen.

Part II In Part II – Information for All Requests, answer question 3 (see Figure 44 on 
page 55). If the answer is Yes, you are stating that:

NOTE Information should be entered in either the Part I section or the Part III 
section, but not both.
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• The entity would be required to take the entire amount of the section 481(a) 
adjustment into account in computing taxable income for the year of change.

• Section 4.02(8) of Rev. Proc. 2002-9 applies to the applicant’s accounting method 
change request, and the applicant is therefore not eligible for a change under auto-
matic change request procedures. (See IRS Form 3115 instructions for details.)

Figure 44: Automatic Change Request information

Part III If this section of the Parts I, III screen is filled out, Form 3115 cannot be e-filed with 
the return. It must instead be paper-filed before submitting the return. A user fee (a 
check or money order payable to the IRS) must be included with the paper-filed form.

If the applicant qualifies for a reduced user fee, enter a check mark on line 23b and go 
to screen ATT2 to complete the attachment information for Part III, line 23b (located 
in the bottom half of the screen). Include the necessary information or certification 
required by Rev. Proc. 2003-1 (or its successor).

Specific statements must also be attached to the return if the applicant answers Yes for 
line 18 (“Is change request allowed under automatic change?”) or No for line 22 (“All 
members of consolidated group use proposed method?”). Press F1 in a specific field 
for more information on attachment requirements. The method for attaching state-
ments in Drake is covered in “Attachments,” starting on page 60.

Parts II and 
IV

Use the Parts II, IV screen to complete the following sections of Form 3115:

• Part II, Information For All Requests

• Part IV, Section 481(a) Adjustment

In addition to the Multi-form code text box, this screen consists of the Part II and 
Part IV sections. All applicants must complete both sections of this screen. For more 
information on each line (including instructions for any required attachments), press 
F1 in a specific field.

Part II, Line 12 Note that there is no field on the Parts II, IV screen for Part II, line 12. Fields for line 
12, which should be completed if the applicant is changing only the accounting 
method for a particular item or items, are located in the top half of ATT2 screen. Use 
these fields to enter information on:

NOTES
See Appendix A of Rev. Proc. 2006-1 for more information. For more on 
applicants who must apply for advance consent, see the IRS Form 
3115 instructions.

Taxpayers filing under an automatic change request procedure do not 
pay a user fee.
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• The items being changed

• The applicant’s present and proposed methods for the items being changed

• The applicant’s present overall method of accounting (cash, accrual, or hybrid)

Note that the bottom half of the ATT2 screen is for completing Part III, line 23b. Only 
the top half (for Part II, line 12) needs to be completed for Part II, line 12.

Schedules A, 
B, and C

Use the A, B, C screen to complete the following sections of Form 3115:

• Schedule A, Change in Overall Method of Accounting (screen covers Part 1, 
Change in Overall Method)

• Schedule B, Change to the Deferral Method for Advance Payments

• Schedule C, Changes Within the LIFO Inventory Method (screen covers both Part 
I, General LIFO Information, and Part II, Change in Pooling Inventories)

Schedule A This section is required for all applicants filing to change their overall method of 
accounting. It requires the entry of amounts as they were at the close of the tax year 
preceding the year of the requested change.

The IRS requires a worksheet for lines 1a, 1c, 1d, 1e, and 1f of Schedule A. When you 
enter an amount on any of these lines in Drake, a Ctrl+W worksheet is automatically 
opened, allowing you to begin entering the descriptions and amounts of multiple items 
for the worksheet. When you close a Ctrl+W worksheet, the program returns to the 
original screen and displays the total in the field. The field is shaded (default is red) to 
indicate that a Ctrl+W worksheet has been used. 

Schedule B This section has just two lines, both referring to the request for deferral for advance 
payments:

• Line 1 — Request change to the deferral method for advance payments (from sec-
tion 5.02 of Rev. Proc. 2004-34)

• Line 2 — Request change to the deferral method for advance payments (from sec-
tion 1.451-5(b)(1)(ii))

See IRS Form 3115 instructions for more information on making these requests.

NOTE
Schedule A, Part II (Change to the Cash Method for Advance Consent 
Request) requires attachments and is not addressed on the A, B, C 
screen.

NOTE
Leave blank any lines that aren’t required for the entity’s application. In 
addition, exclude amounts not attributable to the change in method of 
accounting—for example, amounts that correct a math or posting error, 
or that correct errors in calculating tax liability.

NOTE If nothing is entered in a Schedule A field, the program automatically 
displays the word “NONE” in the field on the generated form.
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Schedule C This section has two parts:

• Part I (General LIFO Information) — This section is made up of attachment links 
(see Figure 48 on page 60). If any of the conditions on lines 1–6 match the entity’s 
situation, click the corresponding attachment link to access the ATT screen, 
where you can complete the required statement. (Select the corresponding line 
code from the Schedule drop list on the ATT screen.)

• Part II (Change in Pooling Inventories) — Enter the descriptions of the contents 
and the base years of the present and proposed pools. If any of the conditions on 
lines 2–4 match the entity’s situation, click the corresponding attachment link to 
access the ATT screen, where you can complete the required statement.

Schedule D, 
Parts I and II

Use the D - I, II screen to complete the following parts of Form 3115, Schedule D, 
Change in the Treatment of Long-Term Contracts Under Section 460, Inventories, or 
Other Section 263A Assets:

• Part I, Change in Reporting Income From Long-Term Contracts

• Part II, Change in Valuing Inventories Including Cost Allocation Changes

Schedule D, 
Part I

A long-term contract refers to any contract for the manufacture, building, installation, 
or construction of property that is not completed in the tax year in which it is entered 
into. Answer the questions in Part I that apply to the entity’s situation.

Schedule D, 
Part II

This section concerns changes in the identification and valuation methods of invento-
ries. Note that some lines require attachments. To access the ATT screen and complete 
a required statement, click the desired attachment link.

The items on this part of the screen match the items on the actual Form 3115, Sched-
ule D. For information on completing individual lines, see the Form 3115 instructions.

Schedule D, 
Part III

Use the D - III screen to complete Part III (Method of Cost Allocation) of Form 3115, 
Schedule D. Part III is required for any entity submitting either Part I or Part II. Screen 
D - III consists of the following sections:

• Section A, Allocation and Capitalization Methods

• Section B, Direct and Indirect Costs Required to be Allocated

• Section C, Other Costs Not Required to be Allocated

NOTE
If an entity is currently using a LIFO inventory method or submethod 
and is changing to another LIFO inventory method or submethod, Part 
II of Schedule D is not applicable. Use Schedule C, Changes Within the 
LIFO Inventory Method, instead.

NOTE

If the entity is unable to furnish a copy of Form 970 (line 5a), the attach-
ment must include the following statement:

“I certify that to the best of my knowledge and belief (name of applicant) 
properly elected the LIFO inventory method by filing Form 970 with its 
return for the tax year(s) ended (insert date(s)) and otherwise complied 
with the provisions of section 472(d) and Regulations section 1.472-3.”
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Section A Click the D3-1 Attachment link (see Figure 46) to attach a description of the present 
and proposed methods used to capitalize direct and indirect costs.

Sections B 
and C

These sections consist of a series of drop lists under a Present column and a Proposed 
column. “Present” refers to the current accounting method, while “proposed” refers to 
the requested change in accounting methods. You should address only the items neces-
sary; do not make a selection for any item for which an answer is not required for the 
entity’s situation.

For each item in sections B and C, you can:

• Select X — If you select X, the corresponding box on Form 3115 will be marked 
with an X. (See Figure 45.)

• Select B — If you select B, the corresponding box on Form 3115 will be left blank 
and an attachment will be required explaining why the line was left blank.

• Select nothing — If you select neither of the above options, “N/A” will appear in 
the corresponding box on Form 3115. No attachment is necessary for a box 
marked “N/A.”

Figure 45: X was selected for column 1, line 1; B was selected for column 1, line 2;
nothing has yet been selected for any other line. (See also Figure 46.)

To attach a statement for section B or C, click the D3-2 Attachment link at the top of 
Section B. (See Figure 46.) A single statement may contain all necessary explanations 
for sections B and C.

Figure 46: If any box is marked “B,” click the D3-2 Attachment link to open
the ATT screen and complete the fields for an attached statement.
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Schedule E

Use screen 311E, accessible from the Change in Accounting Method section of the 
Other Forms tab, to complete Schedule E, Change in Depreciation or Amortization.

Screen 311E 
Multi-form 

Codes

Unlike the other 3115 screens, screen 311E contains two multi-form code text boxes:

• Multi-form code for 3115 — This box is applicable if the return contains more 
than one Form 3115. Enter the code for the instance of the 3115 screen with which 
this 311E screen should be associated.

• Multi-form code for Sch E — This box is applicable if the return contains more 
than one Schedule E. (A separate 311E screen should be used for each property.) 
Assign each property a separate code in its Multi-form code for Sch E. This code 
enables you to associate any attachments with the correct Schedule E property. 
(See “Attachments,” starting on page 60.)

If the return contains more than one Form 3115 and multiple instances of Schedule E, 
both multi-code fields should contain numbers. Figure 47 shows that the third instance 
of a Schedule E is to be associated with the second Form 3115 in the return.

Figure 47: Example of third instance of a Schedule E to be associated
with the second instance of a Form 3115.

Completing 
Schedule E

The 311E screen consists of four sections:

• Schedule E - Line 4a — Enter information on the type of property, the year it was 
placed in service, and the property’s use.

• Schedule E - Change in Depreciation or Amortization — This section covers 
all Schedule E items other than lines 4a and 7. Note that lines 5 and 6 are links to 
required attachments.

• Schedule E - Line 7 - Present Method and Schedule E - Line 7 - Proposed 
Method — For the line 7 sections, enter information on the Present Method and 
Proposed Method in the supplied text boxes and choose the applicable conven-
tion from the Applicable Convention drop list. Options are as follows:

NOTE
If changing this method under the automatic change request proce-
dures, see the “List of Automatic Accounting Method Changes” in the 
IRS Form 3115 instructions.

• HY — Half-Year • MM — Mid-month

• MQ — Mid-quarter • S/L — Straight line
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Attachments

Attached statements are required for many Form 3115 items. Depending on the nature 
of the attachment, you will attach statements to the form in one of two primary ways:

• From Data Entry — The ATT screen is the most common screen for attaching 
statements to Form 3115. The ATT2 screen is used for Part II, line 12, and Part 
III, line 23b. (See the “Parts I and III” and “Parts II and IV” sections of this docu-
ment for more information on completing the ATT2 screen for these items.)

• From View mode — Used for PDF attachments.

 ATT Screen 
Attachments

There are two ways to access the ATT screen in Drake:

• From the Data Entry Menu — In the Change in Accounting Method section of 
the Other Forms tab, click ATT.

• From the line that requires an attachment — As shown in Figure 48, some 
lines have attachment links. Click an attachment link to open the ATT screen.

Figure 48: Attachment links from Schedule C (screen A, B, C)

Complete the following ATT fields, as applicable, for all ATT screen attachments:

• Multi-form codes — Use these boxes to associate the attachment with an 
instance of Form 3115 (if the return contains more than one), a particular Sched-
ule E property (if the return contains more than one Schedule E), or both. (See 
“Multi-form Codes” on page 53 for more information on multi-form codes.)

• Schedule — Select the line of the form or schedule with which the attachment is 
to be associated. If an item begins with a number, it refers to the part of Form 3115 
(for example, 2-4e refers to Part II, line 4e). If it begins with a letter, it refers to a 
particular Form 3115 schedule (for example, C2-b refers to Schedule C, line 2b; 
C2-5 refers to Schedule C, Part 2, line 5).

• Explanation — Enter the statement explanation. If the explanation requires more 
than 900 characters, press PAGE DOWN for a second screen.

NOTE
Not all lines that require statements include a link to the ATT screen. 
Always check the field-level help (click F1 in a field) to determine if a 
statement is required. The program produces an EF Message if any 
required statements are missing.

NOTE
If the explanation requires more than seven screens, only the first 6,500 
characters of the explanation are transmitted with an e-filed Form 3115. 
There is no character limit for paper-filed returns.
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Additional 
ATT Fields

The ATT screen has a separate section, to be used only for Part II, line 10 (“Does the 
applicant... have pending any request... for a private letter ruling, change in accounting 
method, or technical advice?”). The IRS requires that the attached statement, in addi-
tion to providing an explanation, include the taxpayer’s name and ID number. Enter 
the name and ID number, and indicate if the ID number is an EIN, in the applicable 
fields at the bottom of the ATT screen (Figure 49).

Figure 49: Special section for entering taxpayer name and ID number
for Part II, line 10; located at bottom of the ATT screen.

PDF 
Attachments

Some Form 3115 items require the attachment of documents that cannot be created in 
Drake Software; for example, line 4d of Part II requires written consent from a direc-
tor. You can, however, attach such a document to the form as a PDF.

Directions for generating and attaching PDF documents can be found on the PDF 
screen in Drake Software. Directions for converting other types of documents into 
PDF are available by clicking the Screen Help button at the top right corner of the 
PDF screen. Copy or print these instructions as desired.

When the return is generated, an “EF Attachments” worksheet is produced. (See 
Figure 50.) This worksheet shows, in table format, the Reference (section of Form 
3115), the Description, and the IRS-required Filename of each required PDF docu-
ment. This worksheet is displayed as EF_PDF~ in View mode.

Figure 50: Example of an EF Attachments worksheet

NOTE
Once attachments have been filled out, accessing the ATT screen will 
display Existing Forms List of all attachments created. Select the 
attachment (or click the blue New line to create a new attachment), and 
then click Open.

NOTES

Do not enter data on the PDF screen itself. If using the directions pro-
vided on that screen, skip Step 2, which instructs you to fill out the col-
umns at the bottom of the PDF screen.

A PDF document may be attached using any filename. When you 
attach the document, the program automatically assigns it the filename 
required by the IRS.
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Notices of 
Missing 

Attachments

In addition to Form 3115 and related schedules and statements, the program produces 
EF message pages (as applicable) when the return is calculated. All forms, schedules, 
EF message pages, and worksheets are accessible from View mode.

EF messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements, 
specifically, are missing. To best understand which attachments are still required, 
compare the ATT screen and the EF_PDF~ worksheet to the list on the EF message 
page.

NOTE
All EF messages must be eliminated before the return is eligible for 
e-file. EF messages for Form 3115 attachments are eliminated when all 
required statements have been attached to the return.
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Appendix: Trial Balance Import

The trial balance import allows data to be imported into a corporate tax return from a 
trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the fol-
lowing benefits:

• Eliminates the need to duplicate entries

• Eliminates data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
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Appendix B: Adjustment Worksheet

The Adjustment Worksheet is updated each year to help you understand what happens 
in the return when certain data is changed through the use of adjustment fields. The 
following pages contain the 2011 Adjustments worksheet.

These worksheets are also available through the FAQ screen. To access them, open 
the FAQ screen, click the Screen Help button (or press CTRL+ALT+?) and click the 
links at the top of the window.
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Screen/Li

INC - Incom

5

DED - Ded
16a

16b

4

5

6a

6b

7

9b

11 A

11 B

11 D

11 E

11 F

13a A

13a B

13a D

13a E

13a F

13a G

13b H

13c J

13d I

13d K

13d L

13d N

13d O

13d P

13d Q

13d R

 Adjustment Location
     Adjustments Worksheet

Schedule K
ne Field Name Location of Information Being Adjusted

e and Common Schedule K Items

Interest income Adjust amounts flowing from Form 6252

uctions - Form 1065, Page 1 Deductions
Depreciation Adjusts the amounts coming from Form 4562.

Depreciation claimed elsewhere on return  Adjusts amounts coming from Sch A and Form 4562 for forms 
other than the 1065.

Guaranteed payments Adjusts amounts that flow from screen 3, line 10 and K1P 
screen, line 4.

Interest income Adjusts amounts being carried from screen K1P, line 5; K1F, 
line 1; screen 3, line 5; and interest entered on 6252 screens. 

Ordinary dividends Adjusts ordinary dividends flowing from screen 3, line 6a; K1P 
screen, line 6a; and K1F screen, line 2a.

Qualified dividends Adjusts ordinary dividends flowing from screen 3, line 6b; K1P 
screen, line 6b; and K1F screen, line 2b.

Royalties Adjusts amounts entered on K1P screen, line 7.

Collectibles (28%) gain (loss) Adjusts amounts flowing from the K1P screen, line 9b and the 
K1F screen, line 4b.

Other portfolio income (loss) Adjusts amounts flowing from the K1P screen, line 11, code A, 
and the K1F screen, line 5.

Involuntary conversions Adjusts amounts flowing from the K1P screen, line 11, code B.

Mining exploration costs recapture Adjusts amounts flowing from the K1P screen, line 11, code D.

Cancellation of debt Adjusts amounts being carried from screen K1P, line 11, code 
E.

Other income (loss) Adjusts amounts being carried from screen K1P, line 11, code 
F; and K1F, line 11, code D.

Cash (50%) Overrides amounts flowing from screen 3 and from the K1P 
screen, line 13, code A

Cash (30%) Adjusts amounts flowing from the K1P screen, line 13, code B.

Non-cash (30%) Adjusts amounts flowing from the 8283 screen and from the 
K1P screen, line 13, code D.

Capital gain 50% organization (30%) Adjusts amounts flowing from the K1P screen, line 13, code E.

Capital gain property (20%) Adjusts amounts flowing from the K1P screen, line 13, code F.

Contributions (100%) Adjusts amounts flowing from the K1P screen, line 13, code G.

Investment interest expense Adjusts amounts flowing from the K1P screen, line 13, code H.

Section 59(e)(2) expenditures Adjusts amounts flowing from the K1P screen, line 13, code J.

Deductions - royalty income Adjusts amounts flowing from the K1P screen, line 13, code I.

Deduction  - portfolio (2% floor) Adjusts amounts flowing from the K1P screen, line 13, code K.

Deduction - Portfolio (other) Adjusts amounts flowing from the K1P screen, line 13, code L.

Educational assistance benefits Adjusts amounts flowing from screen K1P, line 13, code N.

Dependent care benefits Adjusts amounts flowing from screen K1P, line 13, code O.

Preproductive period expenses Adjusts amounts flowing from the K1P screen, line 13, code P.

Commercial revitalization ded (rental real estate) Adjust amounts flowing from the K1P screen, line 13, code Q.
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 - Income, Deductions & Self-Employment (Screen 1 of 2)
Pensions and IRAs Adjusts amounts flowing from screen K1P, line 13, code R.
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Reforestation expense deduction Adjust amounts flowing from the K1P screen, line 13, code S.

Other deductions Adjusts amounts being carried from screen K1P, line 13, code 
W; and K1F lines 10 and 11A.

Section 754 depreciation/amortization Adjusts amounts flowing from Form 4562.

Other rental real estate credits Adjusts amounts flowing from the K1P screen, line 15, code F.

Other rental credits Adjusts amounts flowing from the K1P screen, line 15, code G.

Undistributed capital gains credit Adjusts amounts flowing from the K1P screen, line 15, code H.

Backup withholding Adjusts amounts being carried from screen K1P, line 15, code 
O, and K1F, line 13, code B.

Other credits Adjust amounts flowing from various credit forms without 
specific K1 codes and the K1P screen, line 15, code P.

tive Minimum Tax (AMT) Items & Other Information (Screen 2 of 2)

Gross income from all sources Adjust amounts flowing from the K1P screen, line 16, code B. 

Passive Adjusts amounts flowing from the K1P screen, line 16, code D.

General Adjusts amounts flowing from the K1P screen, line 16, code E.

Other Adjusts amounts flowing from the K1P screen, line 16, code F.

Interest expense Adjusts amounts flowing from the K1P screen, line 16, code G.

Other Adjusts amounts flowing from the K1P screen, line 16, code H.

Passive Adjusts amounts flowing from the K1P screen, line 16, code I.

General Adjusts amounts flowing from the K1P screen, line 16, code J.

Other Adjusts amounts flowing from the K1P screen, line 16, code K.

Total foreign taxes Adjusts amounts flowing from the K1P screen, line 16, code L 
or code M, and the K1F screen, line 14, code B.

Reduction in taxes available for credit Adjusts amounts flowing from the K1P screen, line 16, code N.

Foreign trading gross receipts Adjusts amounts flowing from Form 8873, line 15, the K1P 
screen, line 16, code O and the K1F screen, line 14, code G.

Extraterritorial income exclusion Adjusts amounts being carried from screen K1P, line 16, code P
and line 52 of Form 8873 (if selected to carry to line 16n).

Other foreign transactions Adjusts amounts flowing from the K1P screen, line 16, code Q.

Post-1986 depreciation adjustment

Adjusts the calculated difference between the current 
depreciation and AMT depreciation totals on the Federal 
Depreciation Listing, amounts flowing from K1P screen, line 17, 
code A or the K1F screen, line 12, code A or G.

Adjusted gain or loss Adjusts amounts flowing from K1P screen, line 17, code B or 
the K1F screen, line 12, code C-F.

Depletion (other than oil and gas) Adjusts amounts flowing from K1P screen, line 17, code C or 
the K1F screen, line 12, code H.

Oil, gas, geothermal-gross income Adjusts amounts flowing from K1P screen, line 17, code D.
Oil, gas, geothermal-deductions Adjusts amounts flowing from K1P screen, line 17, code E.

Other AMT items Adjusts amounts being carried from screen K1P, line 17, code 
F, and screen K1F, line 12, code B, I, and J entries. 
Adjusts amounts flowing from K1P screen, line 18, code A and 
Federal tax-exempt interest
from the K1F screen, line 14, code A.
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Other tax-exempt income Adjusts amounts flowing from the bottom of screen 3, line 18b, 
and from K1P screen, line 18, code B.

Nondeductible expenses Adjusts amounts flowing from the bottom of screen 3, line 18c, 
and  from K1P screen, line 18, code C.

Penalties and fines Adjusts amounts flowing from the bottom of screen 3, line 16c.

Dist of cash  & marketable securities Adjusts amounts flowing from the bottom of screen 3, line 19A, 
and from the K1P screen, line 19, code A.

Distributions subject to section 737 Adjusts amounts flowing from K1P, line 19, code B.

Distributions of other property Adjusts amounts being carried from screen K1P, line 19, code 
C.

Investment income Adjusts amounts being carried from screen K1P, line 20, code 
A, and K1F, line 14 code E

Investment expenses Adjusts amounts being carried from screen K1P, line 20, code 
B.

Fuel tax credit Adjusts amounts being carried from screen K1P, line 20, code 
C.

Recapture of other credits Adjusts amounts flowing from the K1P screen, line 20, code I.

Dispositions of prop with sec 179 deduction
Adjusts the amounts flowing from the WK_179, net gain or loss 
on sale of an asset subject to section 179, and the K1P screen, 
line 20, code L.

Recapture of section 179 deduction Adjusts amounts flowing from Form 4797, line 35 and screen 
K1P, line 20, code M.

Interest expense for corporate partners Adjusts amounts flowing from screen K1P, line 20, code N.

Section 453(l)(3) information Adjusts amounts flowing from the K1P screen, line 20, code O.

Section 453A(c) information Adjusts amounts flowing from the K1P screen, line 20, code P.

Section 1260(b) information Adjusts amounts flowing from the K1P screen, line 20, code Q.

Interest allocable to production expenditures Adjusts amounts flowing from the K1P screen, line 20, code R.

CCF nonqualified withdrawals Adjusts amounts flowing from the K1P screen, line 20, code S.

Information for depletion - oil & gas Adjusts amounts flowing from the K1P screen, line 20, code T.

Reforestation costs Adjusts amounts flowing from the K1P screen, line 20, code U.

Unrelated business taxable income Adjusts amounts flowing from the K1P screen, line 20, code V.

Precontribution gain (loss) Adjusts amounts flowing from the K1P screen, line 20, code W.

Section 108(i) information Adjusts amounts flowing from the K01P screen, line 20, code X

Other information Adjusts amounts flowing from screen K, lines 20Y, screen K1P, 
line 20, code Y, and screen K1F, line 14, code H.

-1 - Partner's Share of Income, Credits, Deductions, etc.
Guaranteed payments - services Adjusts the amount flowing from K screen, line 13M.

djusted Basis Worksheet

Nondeductible expenses and credit adjustments Overrides the calculated amount from the WK_PBAS, page 2, 
current-year losses and deductions, line 8a.

-1 - Reconciliation of Income (Loss) per Books with Income (Loss) per return
Income recorded on Schedule K but not on books: 
Other

Adjust the amounts flowing from Forms 6478 and 8864 credit 
adjustments.

Expenses recorded on books but not on Schedule K: 
Other

Adjust amounts credit adjustments made from Forms 5884, 
5884A, 6765, 8820, 8844, 8845, 8846, 8881, nondeductible 
expenses entered on the bottom of screen 3 for line 18c and 

amounts entered on K3 screen for line 18c for nondeductible 
expenses.
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3
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5
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Income recorded on books but not on Schedule K, 
lines 1 through 11: Other Adjusts amount flowing from Schedule K, line 18B. 

Carryover of disallowed deduction from prior year Adjusts amounts from the 4562 screen.
 - Work Opportunity Credit

Work opportunity credit from pass-through entities Adjusts amounts from K1P screen, line 15, code J, and K1F 
screen, line 13, code F.

 - Alcohol and Cellulosic Biofuel Fuels Credit

Pass-through credit from other entities Adjusts amounts from K1P screen, line 15, code I, and K1F 
screen, line 13, code H.

 - Credit for Increasing Research Activities

Pass-through research credits Adjusts amounts from K1P screen, line 15, code M, and K1F 
screen, line 13, code I.

 - Orphan Drug Credit
Orphan drug credit(s) from pass-through entities Adjusts amounts from K1F screen, line 13, code  M.

 - Disabled Access Credit
Disabled access credits from pass-through entities Adjusts amounts from K1P screen, line 15, code K.

 - Empowerment Zone Employment Credit

Form 8844 credits from pass-through entities Adjusts amounts from K1P screen, line 15, code L, and K1F 
screen, line 13, code K.

an Employment Credit
Form 8845 credits from pass-through entities Adjusts amounts from K1F screen, line 13, code L.

 - Credit for Employer SS and Medicare Taxes Paid on Certain Employee Tips
Form 8846 credits from pass-through entities Adjusts amounts from K1P screen, line 15, code N.

 - Biodiesel Fuels Credit
Biodiesel and renewable diesel fuels credit from pass-
through entities Adjusts amounts from K1F screen, line 13, code O.

it for Employer-Provided Childcare Facilities and Services
Amount Adjusts amounts from K1F screen, line 13, code N.

 Nonconventional Source Fuel Credit
Nonconventional source fuel from partnerships, S 
corporations, estates and trusts Adjusts amounts from K1F screen, line 13, code P.

 Energy Efficient Appliance Credit
Energy-efficient appliance credit from partnerships, S 
corporations, estates, trusts, and cooperatives

An entry here adjusts amounts being carried from K1F screen, 
line 13, code S.

 - Credit for Small Employer Health Insurance Premiums
Credit from partnerships, C corporations, cooperatives, 
estates, and trusts

Adjusts amounts from K1P screen, line 15, code P, and K1F 
screen, line 13, code G.

 - Farm Income (Informational Purposes Only)
Depreciation Amount is carried from Form 4562 calculations.

ntal Other than Real Estate

Depreciation Adjusts depreciation amounts calculated by the program from 
entries on the 4562 screens.

 - Rental Real Estate
Depreciation Adjusts the depreciation calculated from the 4562 screens

 - Domestic Production Activities Deduction
Qualified production activities income from pass-
through entities

Adjusts amounts from K1P screen, line 13, code U and K1F 
screen, line 14, code C.

Form W-2 wages from pass-through entities Adjusts amounts from K1P screen, line 13, code V, and K1F 
screen, line 14, code D.

 Part IV - Tax and Payments

Other credits Adjusts amount flowing from screen 80 common credits 5735 
and 8834

- Adjustments and Payments

Adjustments: Amount Adjusts amount to be printed on the client's bill; corresponds to 
the description on the BILL screen.
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Drake Software User’s Manual Supplement: Partnership
Appendix C: Override Worksheet

The Override Worksheet is updated each year to help you understand what happens in 
the return when certain data is changed through the use of override fields. The follow-
ing pages contain the 2011 Override worksheet.

These worksheets are also available through the FAQ screen. To access them, open 
the FAQ screen, click the Screen Help button (or press CTRL+ALT+?) and click the 
links at the top of the window.
Tax Year 2011 C-1
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     Overrides Worksheet
Override Location
n/Line Field Name Location of Information Being Overridden 

ership General Information screen
I Number of Schedules K-1 attached Overrides the number of K-1 schedules that are generated.
Preparer fee Overrides the system's fee calculation
Firm # Overrides the program default setting (1).
Preparer # Overrides the program default setting (1).
Data entry op # Overrides the login name.

ERO number Overrides the selection made from the ERO SSN Indicator drop 
list at Setup > Options, EF tab.

Entity Name Control Overrides the calculated name.
come and common Schedule K Items

Publicly Traded Partnership Electing 3.5% Tax Overrides the calculated tax on the total income from the active 
conduct of all trades and businesses by the partnership.

eductions - Form 1065, Page 1 Deductions

Insurance (enter total if not using detail below) Overrides the amounts entered on the other insurance lines on 
this screen.

1 State income taxes Overrides state income taxes calculated from information 
entered on ES screen using code IN.

2 State franchise  taxes Overrides state franchise taxes calculated from information 
entered on ES screen using code FR..

125-A - Cost of Goods Sold

5 Other costs - depreciation Overrides calculated amount for entries on 4562 detail screen 
directed to the COGS in the Form selection box.

le B - Other Information 

6 If "Yes," enter number of Forms 8805 filed for 
partnership Overrides the number of Forms 8805 generated by the program.

P Partner #
System prints first partner's info as Tax Matters Partner by 
default. Enter a partner number here to select a different partner 
as the TMP.

SSN Overrides the selected partner's info as Tax Matters Partner by 
default.

TMP Name Overrides the selected partner's info as Tax Matters Partner by 
default.

Address Overrides the selected partner's info as Tax Matters Partner by 
default.

City Overrides the selected partner's info as Tax Matters Partner by 
default.

State, ZIP Overrides the selected partner's info as Tax Matters Partner by 
default.

Province/State, Country, Postal Code Overrides the selected partner's info as Tax Matters Partner by 
default.

Phone number Overrides the selected partner's info as Tax Matters Partner by 
default.

le K - Partners' Distributive Share (Screen 1 of 2)
 (M) Amount paid for medical insurance Overrides amounts being carried from screen 3, line 10
4a Net earnings from self-employment Overrides the calculated on WK_SE.

4b Gross farming/fishing income Adjusts amounts from K1P screen, line 14, code B; K1F screen, 
line 14, code G; and Schedule F.

4c Gross non-farm income Overrides the calculated amount as follows: Form 1065, line 8, 
plus schedule K, line 3a, minus Form 1065, lines 5 and 6.

le K - Alternative Minimum Tax (screen 2 of 2)

a K - Analysis by type of partner - General Partners Overrides amount calculated by the program based on the 
selection made in the Type of Partner section of the K1 screens.

b K - Analysis by type of partner - Limited Partners
Overrides amount calculated by the program based on the 
selection made in the Type of Partner section of the K1 
screens.

ployment Earnings/Loss Worksheet

b Net income (loss) from certain rental real estate 
activities if different from the amount on Sch K, line 2

Overrides amounts on Schedule K, line 2 (Form 8825) which 
flows to worksheet for figuring Net Earnings (Loss) From Self-
Employment, line 1b when selected on the 8825 screen.

d Net loss from Form 4797, Part II, line 17, included on 
line 1a (enter as a positive amount) Overrides the loss that comes from Form 4797 Part II line 17

1065
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     Overrides Worksheet
Override Location
n/Line Field Name Location of Information Being Overridden 

ership General Information screen
I Number of Schedules K-1 attached Overrides the number of K-1 schedules that are generated.
Preparer fee Overrides the system's fee calculation
Firm # Overrides the program default setting (1).
Preparer # Overrides the program default setting (1).
Data entry op # Overrides the login name.

ERO number Overrides the selection made from the ERO SSN Indicator drop 
list at Setup > Options, EF tab.

Entity Name Control Overrides the calculated name.
come and common Schedule K Items

Publicly Traded Partnership Electing 3.5% Tax Overrides the calculated tax on the total income from the active 
conduct of all trades and businesses by the partnership.

eductions - Form 1065, Page 1 Deductions

Insurance (enter total if not using detail below) Overrides the amounts entered on the other insurance lines on 
this screen.

1 State income taxes Overrides state income taxes calculated from information 
entered on ES screen using code IN.

2 State franchise  taxes Overrides state franchise taxes calculated from information 
entered on ES screen using code FR..

125-A - Cost of Goods Sold

5 Other costs - depreciation Overrides calculated amount for entries on 4562 detail screen 
directed to the COGS in the Form selection box.

le B - Other Information 

6 If "Yes," enter number of Forms 8805 filed for 
partnership Overrides the number of Forms 8805 generated by the program.

P Partner #
System prints first partner's info as Tax Matters Partner by 
default. Enter a partner number here to select a different partner 
as the TMP.

SSN Overrides the selected partner's info as Tax Matters Partner by 
default.

TMP Name Overrides the selected partner's info as Tax Matters Partner by 
default.

Address Overrides the selected partner's info as Tax Matters Partner by 
default.

City Overrides the selected partner's info as Tax Matters Partner by 
default.

State, ZIP Overrides the selected partner's info as Tax Matters Partner by 
default.

Province/State, Country, Postal Code Overrides the selected partner's info as Tax Matters Partner by 
default.

Phone number Overrides the selected partner's info as Tax Matters Partner by 
default.

le K - Partners' Distributive Share (Screen 1 of 2)
 (M) Amount paid for medical insurance Overrides amounts being carried from screen 3, line 10
4a Net earnings from self-employment Overrides the calculated on WK_SE.

4b Gross farming/fishing income Adjusts amounts from K1P screen, line 14, code B; K1F screen, 
line 14, code G; and Schedule F.

4c Gross non-farm income Overrides the calculated amount as follows: Form 1065, line 8, 
plus schedule K, line 3a, minus Form 1065, lines 5 and 6.

le K - Alternative Minimum Tax (screen 2 of 2)

a K - Analysis by type of partner - General Partners Overrides amount calculated by the program based on the 
selection made in the Type of Partner section of the K1 screens.

b K - Analysis by type of partner - Limited Partners
Overrides amount calculated by the program based on the 
selection made in the Type of Partner section of the K1 
screens.

ployment Earnings/Loss Worksheet

b Net income (loss) from certain rental real estate 
activities if different from the amount on Sch K, line 2

Overrides amounts on Schedule K, line 2 (Form 8825) which 
flows to worksheet for figuring Net Earnings (Loss) From Self-
Employment, line 1b when selected on the 8825 screen.

d Net loss from Form 4797, Part II, line 17, included on 
line 1a (enter as a positive amount) Overrides the loss that comes from Form 4797 Part II line 17

1065
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 (a) Intangible assets Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

 (c ) Intangible assets Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

 (a) Less accumulated amortization Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

 (c ) Less accumulated amortization Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

le M-1 - Reconciliation of Income (Loss) per Books with Income per Return

4 Expenses recorded on books but not on Schedule K: 
Book-to-tax depreciation

Overrides amount calculated by system of the difference 
between book and tax depreciation.

7 Deductions included on Schedule K but not charged 
against book income this year

Overrides the book-to-tax depreciation adjustment calculated by 
the system.

le M-2 - Analysis of Partner's Capital 

3 Net income (loss) per books Overrides the amount carried from Schedule M-1, line 1, or 
Schedule M-3, line 11.

le M-3 - Net Income (Loss) Reconciliation, Part I

2 Income statement period - Beginning Overrides default calendar year dates or fiscal year dates 
entered on screen 1

2 Income statement period - Ending Overrides default calendar year dates or fiscal year dates 
entered on screen 1

ptions Print Overrides
Print federal filing instructions An entry here overrides the selection on Setup > Options,  

Optional Documents tab for printing the federal return.
Print state filing instructions An entry here overrides the selection at Setup > Options, 

Optional Documents tab for printing the state return.
Print partnership's envelope coversheet An entry here overrides the option that was entered in Setup > 

Options, Optional Documents for the S corporation envelope 
coversheet.

Print IRS envelope coversheet An entry here overrides the option that was entered in Setup > 
Options, Optional Documents tab for the IRS envelope 
coversheet.

Print state envelope coversheet An entry here overrides the option that was entered in Setup > 
Options, Optional Documents tab, for the state envelope 
coversheet.

Print city envelope coversheet An entry here overrides the option that was entered in Setup > 
Options, Optional Documents tab, for the city envelope 
coversheet.

Date to print on returns Overrides the default date on the "Paid Preparer" line at the 
bottom of the 1120, page 1.

Form 1065, Box F - Total Assets Overrides the calculated amount on Form 1065 page 1, line F.

IRS Center Overrides the IRS Center address generated from the General 
Information screen.

hedule D - Gain/Loss Carryovers and Other Entries

5 Partnership share of net short-term capital gain (loss) Overrides the amounts coming from the K-1P screen,
line 8, and the K-1F screen, line 3.

1 Partnership share of net long-term capital gain (loss) Overrides the amounts coming from the K-1P screen,
line 9a, and the K-1F screen, line 4a.

562 Detail

Override regular depreciation,   Federal Overrides the system calculation for the "Current depr" column 
of the Depreciation Detail Listing.

Override regular depreciation,   AMT (if different) Overrides the system calculation for the "AMT Current" column 
of the Depreciation Detail Listing.

Override regular depreciation,   Book (if different) Overrides the calculated book amount.

179 expense elected this year,  Federal Overrides Form 4562, Part I, line 6, column (c) and the amount 
for the WK_S179L

179 expense elected this year,   Book (if different) Overrides the calculated book amount and the amount for the 
WK_S179L..



Scree

     Overrides Worksheet
Override Location

"Fo
conve
"Do n
MAC

tab
6 4562

1
Form 3

5

5

6

1

1

1

1

1

1

1

1

Form 6

Form 8

K1P Sc
n/Line Field Name Location of Information Being Overridden 
1065

179 expense ALLOWED this year,   Federal

Overrides Form 4562 line 12 (If Method M is chosen there must 
be an entry made on line 179 expense elected this year or 
Method EXP must be used). Overrides amount calculated for 
WK_S179L.

179 expense ALLOWED this year,   Book (if different) Overrides the calculated book amount and the amount for the 
WK_S179L.

rce 
ntion" Placed in Service and Like-Kind Exchange Info Overrides convention determined by the dates of assets placed 

in service during the year.
ot use 
RS % 
les"

Placed in Service and Like-Kind Exchange Info Overrides how the system calculates depreciation for the "Life" 
and "Method" columns of the Depreciation Detail Listing.

 Part 1

1 1 Maximum amount if greater than $250000 Overrides the maximum of 179 expense for 2009 of $250,000 on 
line 1 of Form 4562

2 2 Total cost of sec 179 property placed in service in 
current year

Overrides the software calculated amount of section 179 
property placed in service during the tax year.

8 Total business income  Federal Overrides calculated amount on WK_P179L, line 4.
468

a
Qualifying advanced coal project credit, Basis of 
investment in gasification for section 49A(d)(3)(B)(i) 
projects

Overrides the cost entered on the 4562 detail screen as 
determined by the code (CA) entered in the Investment credit 
code drop list.

b
Qualifying advanced coal project credit, Basis of 
investment in coal-based generation for section 
49A(d)(3)(B)(ii) projects

Overrides the cost entered on the 4562 detail screen as 
determined by the code entered in the Investment credit code 
drop list.

b Qualifying gasification project credit, Basis of 
investment property not included in (a) above

Overrides the cost entered on the 4562 detail screen as 
determined by the code entered in the Investment credit code 
drop list.

1e Rehabilitation property, Pre-1936 buildings in the Gulf 
Opportunity Zone

Overrides the cost entered on the 4562 detail screen as 
determined by the code (RA) entered in the Investment credit 
code drop list.

1g Rehabilitation property, Other pre-1936 buildings
Overrides the cost entered on the 4562 detail screen as 
determined by the code (RB) entered in the Investment credit 
code drop list.

1h Rehabilitation property, Certified historic structures in 
the Gulf Opportunity Zone

Overrides the cost entered on the 4562 detail screen as 
determined by the code (RC) entered in the Investment credit 
code drop list.

1j Rehabilitation property, Other certified historic 
structures

Overrides the cost entered on the 4562 detail screen as 
determined by the code (RD) entered in the Investment credit 
code drop list.

2a Energy Credit, Basis of property using geothermal 
energy placed in service during 2009

Overrides the cost entered on the 4562 detail screen as 
determined by the code (EA) entered in the Investment credit 
code drop list.

2b Energy Credit, Basis of property using solar illumination 
or energy placed in service during 2009

Overrides the cost entered on the 4562 detail screen as 
determined by the code (EB) entered in the Investment credit 
code drop list.

2c Energy Credit, Qualified fuel cell property: Basis of 
property installed

Overrides the cost entered on the 4562 detail screen as 
determined by the code (EC) entered in the Investment credit 
code drop list.

2i Energy Credit, Qualified microturbine property: Basis of 
property installed

Overrides the cost entered on the 4562 detail screen as 
determined by the code (ED) entered in the Investment credit 
code drop list.

478 - Alcohol and Cellulosic Biofuel Fuels Credit

2 Alcohol 190 proof or greater and alcohol 190 proof or 
greater in fuel mixtures Overrides the default rates. Refer to form instructions.

3
Alcohol less than 190 proof but at least 150 proof and 
alcohol less than 190 proof but at least 150 proof in 
fuel mixtures

Overrides the default rates. Refer to form instructions.

4 Qualified cellulosic biofuel produced after 2008 that is 
alcohol Overrides the default rates. Refer to form instructions.

609 - Low-Income Housing Credit Allocation & Certification

2 Schedule A - Annual Statement, Override of computed 
rate Overrides computed rate.

hedule K-1 for 1065



Scree

     Overrides Worksheet
Override Location

SS-4 - 

Form 9

3115 C

2

Form 8

Form 8

Form 8

Form 8

Form 8

Form 8

3

6

Form 8
4
4

Form 8
5
5

4

Form 8

Client 
n/Line Field Name Location of Information Being Overridden 
1065

For section 179 Use Only,  2009 179 exp allowed Overrides the calculated amount allowed on the WK_P179L.

For section 179 Use Only,  2008 179 exp allowed Overrides the calculated amount allowed on the WK_P179L.

Current year QRP 179 exp allowed Overrides calculated amount.

Application for Employer Identification Number
County & state Overrides the county and state entered on screen 1.
Date business started/acquired Overrides the date entered on screen 1.

82 - Reduction of Tax Attributes Due to Discharge of Indebtedness
Part III - Consent of Corporation to Adjustment of Basis 
of Property Overrides the dates entered on screen 1

hange in Accounting Method
General Information - Principal business activity code 
number Overrides selection made on screen K, line 2a.

Tax year of change begins Overrides entry made on screen 1 (Name, Address, General 
Info).

Tax year of change ends Overrides entry made on screen 1 (Name, Address, General 
Info).

Contact person's telephone number Overrides entry made on screen 1 (Name, Address, General 
Info).

5 Parts II,IV Section - Net Section 481(a) adjustments for 
the year of change Overrides amount flowing from Form 3115, section A, line 1h.

027 Employer's Annual Information Return of Tip Income and Allocated Tips

7 Allocation of tips if using other than calendar year Overrides calculated amount for line 7 of form; place X in line 6 
to activate this override.

082 - Notice of Inconsistent Treatment or Administrative Adjustment 

7 Partnership tax year Overrides default calendar year dates or fiscal year dates 
entered on screen 1.

283 - Noncash Charitable Contributions

Restrictions, Override section Changes information on Form 8283 from section A to section B 
or vise versa.

308 - Report of a Sale or Exchange of Certain Partnership Interest
Part I Beneficial owner of the interest immediately 
before the transfer

Overrides the information that flows from Schedule K-1 - Partner 
Name and Address Information.

Part II Beneficial owner of the interest immediately after 
the transfer

Overrides the information that flows from Schedule K-1 - Partner 
Name and Address Information.

716 - Election to Have a Tax Year Other Than a Required Tax Year
4 Date of required tax year Overrides calculated date based on return type election.
804 - Annual Return for Partnership Withholding Tax

a Number of Foreign Partners Overrides calculated number of foreign partners from K-1 
screens when Foreign partner check box is marked.

a Payments of section 1446 tax made by partnership and 
amount credited from last year Overrides amount of quarterly payments from Forms 8813.

822 - Change of Address
a Business name Overrides entry on screen 1.
b Employer ID number Overrides entry on screen 1.

6 New mailing address Overrides entry on screen 1.
8 Daytime phone number Overrides entry on screen 1.
873 - Extraterritorial Income Exclusion
a Business activity code Overrides information entered on screen 1.
b Product Overrides information entered on screen 1.

5 Part IV, line 45 Overrides calculated results for line 42: override and enter 
amounts from lines 33, 36, 38, or 44.

925 - Report of Employer-Owned Life Insurance Contracts
Type of business Overrides information entered on screen 1.

Bill - Adjustments and Payments

Billing option (overrides what is set up in options) Overrides the billing option selected in Setup > Options > 
Billing.

Custom paragraph option (overrides what is setup in 
options)

Overrides the Custom Paragraph option selected in Setup > 
Options > Billing.

Date to be printed on bill Overrides the default date (the present date).



Drake Software User’s Manual Supplement: Partnerships Index
Index

Numerics
52-53-week year returns 39

A
accounting method

changing 39, 53
entering on 1065 5

accrual (accounting method) 5
address

change of 5
e-mail 17
entering on Form 1065 4
foreign 21
on K-1 letter heading 26
out-of-state 18

adjusted basis worksheet 22, 23–24, 37
adjustment fields, guide to 19
adjustments

depreciation 29
to income and expenses 34

allocations
section 754 24
special (screen SA) 21, 24

alternative minimum tax (AMT) 19
amending

a 1065 return 5, 14
and TEFRA audit rules 14
K-1 letters 27

amortization 11, 13, 27
analysis

of capital accounts (Schedule M-2) 31
asterisks (on K-1 codes) 20
attachments

binary 40–43
Form 8825 33
to Form 3115 53, 57, 59

auto-balance 29, 38, 44

B
bad debts 7, 9
bankruptcy returns, e-filing not allowed for 38
basis 23–24

see also adjusted basis worksheet
book-to-tax differences (Schedule M-1) 29–30
business activity codes 4

C
calendar year returns 4, 13
cash (accounting method) 5, 9, 56
change

of name or address 5
charitable contributions 5
Client Communications Editor (for letters) 26
codes

business activity 4
error/reject 40
K-1 20, 37
miscellaneous (screen 1) 18
multi-form 32, 53, 59, 60

compensation of partners 8
contact information (for state returns) 16
contributions, charitable 5
cost of goods sold, see  Schedule A (Cost of Goods Sold)
cover letters (K-1) 26
coversheets 38
credits 7, 13, 34
Ctrl+W (detail) worksheets 6, 7, 44, 56

D
data entry

for state information 17
importing trial balance into 43–52
state tabs in 17

dates
business start 4
tax year 4

decrease to basis 23
deductions 8–13, 25
depletion 12
depreciation

entering 10–12
for cost of goods sold (Schedule A) 6
of rentals 10, 32
on short-year returns 4
printing Form 4562 37
trial balance (business returns only) 50

detail (Ctrl+W) worksheets 6, 7, 44, 56
domestic production activities deduction 25
due dates 13

E
e-filing 38
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Form 8879-PE 14
PDF attachments 40
statements 28

electronic signatures (PIN) 13
employee benefit plans 12
envelope coversheets 38
error codes 40
expenses 8–13
exporting K-1 data 21
extensions 13, 38

F
farm profit or loss 7
filing instructions 38
final return 5
fiscal year returns 4
foreign

addresses for partners 21
ownership 15
transactions 19

Form 1099-K (Merchant Card and Third-Party Network 
Payments) 6

Form 1125-A 2
Form 3115 (Application for Change in Accounting Meth-

od) 39, 42, 53–62
Form 4562 (Depreciation and Amortization) 32, 37
Form 5884 (Work Opportunity Credit) 35
Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit)

7, 34
Form 6765 (Credit for Increasing Research Activities) 13, 

35
Form 7004 (Application for Automatic Extension of Time 

to File) 13
Form 8082 (Notice of Inconsistent Treatment or Amended 

Return) 14
Form 8820 (Orphan Drug Credit) 13, 35
Form 8825 33
Form 8825 (Rental Real Estate Income and Expenses of a 

Partnership or an S Corporation) 31–34
Form 8844 (Empowerment Zone and Renewal Community 

Credit) 35
Form 8845 (Indian Employment Credit) 35
Form 8846 (Credit for Employer Social Security and Medi-

care Taxes Paid on Certain Employee Tips) 9, 35
Form 8864 (Biodiesel and Renewable Diesel Fuels Credit)

7, 34
Form 8873 (Extraterritorial Income Exclusion) 13
Form 8879-PE (IRS e-file Signature Authorization for 

Form 1065) 14
Form 8881 (Credit for Small Employer Pension Plan Star-

tup Costs) 35
Form 8893 (Election of Partnership Level Tax Treatment)

37

Form 8903 (Domestic Production Activities Deduction) 25
Form 8912 (Credit to Holders of Tax Bonds) 34
Form 8912 (Credit to Holders of Tax Credit Bonds) 35
Form 8916A (Supplemental Attachment to Schedule M-3)

31
Form 8941 (Credit for Small Employer Health Insurance 

Premiums) 35
Form 8941 (Credit for Small Employer Health-Insurance 

Premiums) 13
Form T (Forest Activities Schedules) 12

G
gains and losses 7
gross receipts 6
guaranteed payments 8

H
header information 3
health insurance 12
health savings account (HSA) 9

I
importing trial balance 43–52
inactive returns 39
income 5–7
increase to basis 23
instructions for filing 38
insurance

and contributions to benefit plans 12
entering deductible payments for 8
proceeds, income from 7

interest
expense 9
income 7
ownership of (Schedule B) 15–16

inventory (on Schedule A, Cost of Goods Sold) 6
IRAs 12
Item M (on Schedule K-1) 22

K
K-1, Schedule for 1065 19–23

L
letters (K-1) 26

M
M, item (on Schedule K-1) 22
maintenance costs 9
medical care for employees 12
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Multi-State Apportionment 2, 17

N
name change 5
net

farm profit or loss 7
gain or loss 7

next-year depreciation listing 37
number of partners 5

O
ordinary gains and losses 7
other

costs (Schedule A) 6
income (loss) 7

overrides
guide to 19
of calculations for partners 21
on screen 1 18

ownership
of interest (Schedule B) 15

P
partners

compensation of 8
foreign addresses for 21
guaranteed payments to 8
health insurance for 12
number of 5
returns with numerous 20
Schedule K-1 19
special allocations for 24
updating data annually 23

partnership, termination of 5
payments, guaranteed 8
PDF 41
PDF documents, e-filing 40–43
PIN (electronic) signatures 13
printing

1065 returns 36
adjusted basis worksheets 37
cover letter for K-1 26
force 36
Form 8903 for each partner 25
K-1 items 20
suppressing/forcing documents 37

prior-year returns, updating 3

R
real estate 51
receipts 6

refunds, state 7
reject codes 40
rent paid on business property 9
rental activities 31–34
repair costs 9
resident state 16, 18
retirement plans 12
returns

52-53-week year 39
bankruptcy 38
extensions for 13
fiscal and calendar year 4
inactive 39
short-year 4
signing 13
tax-exempt organizations (990) 40–43
updating prior-year 3

S
scanning attachments for e-filing 40
Schedule A (Cost of Goods Sold) 6–7
Schedule B (Other Information) 15
Schedule D (Capital Gains, Losses, Built-In Gains) 9
Schedule D, Form 3115 57
Schedule E (Change in Depreciation or Amortization) 

(Form 3115) 59
Schedule E, Form 3115 59
Schedule K (Partners’ Distributive Share Items) 5, 19
Schedule K-1 (Partner Information) 19–23
Schedule L (Balance Sheet per Books) 27–29, 37
Schedule M-1 (Reconciliation of Books With Return) 37
Schedule M-1 (Reconciliation of Books) 29
Schedule M-2 (Analysis of Capital Accounts) 31
Schedule M-3 (Net Income (Loss) Reconciliation) 30
section

179 11, 23
481 7
754 11, 24

self-employment income 34
SEP or SIMPLE plans 12
short-year returns 4
signatures, electronic 13
special allocations (screen SA) 21, 24
state

overriding information related to 18
resident 16
tabs in data entry 17
tax refunds 7

state-specific information 16

T
tax
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returns, see returns
years (fiscal vs calendar) 4

Tax Equity and Fiscal Responsibility Act (TEFRA) 14
taxes and licenses 9
technical termination 5
termination of partnership 5
trial balance import

and depreciation 6
and SCH2 screens 28
instructions for using 43–52

U
updating

a prior-year return 3
partner data annually 23

V
Vista (Windows operating system) 44, 45, 48

W
wages 8
viii Tax Year 2011
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